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Annexure A

Refinement of Nodal Mesh
based on Mass Modeling Frequency



Refinement of Nodal Mesh based on Mass Modeling Frequency

The purpose of this feature is to ensure that there are a sufficient number of mass points for an accurate
dynamic model for the dynamic loading under consideration.

Intermediate mass points along a span are generated based on the free vibration of an equivalent simply
supported beam. Optimum element length is calculated from:

L _l|m |ELg
ot = 12.F w

Lopt = Optimum length required to capture the span dynamic behavior
f = mass modeling frequency

g = acceleration due to gravity

E = modulus of elasticity of pipe material

Although the above equation is valid for any temperature, to generate intermediate nodes, E is taken at
the reference temperature entered in CAEPIPE.

I = moment of inertia of pipe cross section
w = weight per unit length of pipe (including insulation, lining and content)
Intermediate mass points can be automatically generated in CAEPIPE by selecting the radio button

“‘Dynamic Analysis” through Layout window > Edit > Refine Nodal Mesh. Enter the Mass modeling
Frequency in the dialog box shown and press the button “OK”. See figures shown below for details.
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While refining the Nodal Mesh, the new node numbers will be generated by adding the node increment
specified through Layout window > Options > Node increment to get the new node numbers (without
affecting the original node numbers used in the Layout window). Hence, set the node increment value as
required before refining the Nodal Mesh.

Upon refining the Nodal Mesh based on Mass modeling frequency, CAEPIPE will prompt for renumbering
of nodes as shown below.

Slope...

[= (=[]~ [=]=]=]]
‘

Rotate... APl |12 |1

Chabaes &R 12 U
C Ctrl+B
Renumber nodes..,

Refine Nodal Mesh Ctrl+R

=
—

Generate..

Regenerate

Duplicate last row Ctrl+Enter

Caepipe e Renumber Nodes b4

Fows: Fram "I_ To # |27B

Starting node |10
Increase node numbers |10
Ok | Cancel |

Press the button “Yes” to renumber the nodes and enter the details required by CAEPIPE in the dialog
box. See snap shot shown above.




Example

A sample CAEPIPE model (with graphics and layout details as shown below) was chosen for verification
of implementation. Modal analysis was then performed by defining the cut-off frequency and number of
modes as “110 Hz” and 175 respectively in the CAEPIPE model through Layout window > Options >

Analysis > Dynamics with the node points as defined by the stress analyst.
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Piping code = B31.3 (2014)

Do not use liberal allowable stresses
Include axial force in stress calculations
Reference temperature = 40 (F)

Number of thermal cycles = 7000
Number of thermal loads =1

Thermal = Operating - Sustained

Use modulus at reference temperature
Include hanger stiffness

Include Bourdon effect

Use pressure correction for bends
Pressure stress = PD / 4t

Peak pressure factor = 1.00

Cut off frequency = 110 Hz

Number of modes = 175

Include missing mass correction

Use friction in dynamic analysis
Vertical direction =Y

# Node Type DX (ft'in") DY (ft'in") DZ(ft'in") Mat Sec Load Data

1 Title =

2 10 From Anchor

3 20 Bend 11'o" API 541 541

4 30 -20'0" API 541 541

5 40 Bend -10'9" API 541 541

6 50 9ro" API 541 541 Y restraint
7 60 2'0" API 540 540

8 65 10'o" APIT 540 540

9 70 12'0" API 540 540 Y restraint
10 75 12'o" APIT 540 540

11 80 12'o" API 540 540 Y restraint
12 85 12'o" APIT 540 540

13 90 12'0" API 540 540 Y restraint
14 100 11'o" APIT 540 540

15 110 3'o" APIT 540 540 Anchor

16 120 3'o" API 540 540

17 130 Reducer 3'o" APIT 540 540

18 140 Bend 3'8" API 36T 36T

19 150 Bend 2'11" -4'6" 4'6" API 361 361
20 160 6'o" API 361 361 Y restraint
21 165 7ro" API 361 361
22 170 7'o" API 361 361 Y restraint
23 180 Bend 6'0" APIT 361 36l
24 190 73" API 361 361 Y restraint
25 200 12'o" API 361 361 Y restraint
26 210 12'o" API 361 361
27 220 12'o" APIT 36l 361 Y restraint
28 230 Bend 4'5" API 361 361
29 240 4'5" APIT 361 361 Y restraint
30 250 12'o" API 361 361
31 260 12'o" API 361 361 Y restraint
32 270 12'0" API 361 361
33 280 12'o" API 361 361 XY restraint



Caepipe dynamic model original Page 2

Version 7.60 May 30,2016

# Node Type DX (ft'in") DY (ft'in") DZ(ft'in") Mat Sec Load Data

34 290 12'o" API 361 361

35 300 12'o" API 361 361 Y restraint
36 310 12'o" API 361 361

37 320 12'o" API 361 361 Y restraint
38 330 16'0" API 36I 36I XY restraint
39 340 12'o" API 361 361

40 350 12'0" API 361 361 Y restraint
41 360 12'o" API 361 361

42 370 12'o" API 361 361 Y restraint
43 380 12'o" API 361 361

44 390 12'o" API 361 361 XY restraint
45 400 12'o" API 361 361

46 410 12'o" API 361 361 Y restraint
47 420 12'0" API 361 361

48 430 12'o" API 361 361 Y restraint
49 440 12'o" API 361 361

50 450 12'o" API 361 361 XY restraint
51 460 12'o" API 361 361

52 470 12'o" API 361 361 Y restraint
53 480 12'o" API 361 361

54 490 12'o" API 361 361 Y restraint
55 500 12'o" API 361 361

56 510 12'o" API 361 361 Anchor

57 520 12'o" API 361 361
58 530 12'o" API 361 361 Y restraint
59 540 12'o" API 361 361

60 550 12'o" API 361 361 Y restraint
61 560 Bend 4'5" API 361 361

62 570 -4'5" API 361 361 Y restraint
63 580 -12'0" API 361 361

64 590 -11'7" API 361 361 Y restraint
65 600 -12'0" API 361 361

66 610 -12'0" API 361 361 XY restraint
67 620 -12'0" API 361 361

68 630 -12'0" API 361 361 Anchor

69 640 -12'0" API 361 361
70 650 -12'0" API 361 361 XY restraint
71 660 -12'0" API 361 361
72 670 -10'0" API 361 361 Y restraint
73 680 -13'0" API 361 361 Y restraint
74 690 Bend -9'o" API 361 361
75 700 7rilm API 361 361 Y restraint
76 710 12'0" API 361 361 Anchor
77 100 From
78 720 Bend 10'9" APIT 360 360
79 730 7'o" APIT 360 360 Y restraint
80 740 Bend 9'o" APIT 360 360

81 750 le'9" APIT 360 360

82 760 26'11" APIT 360 360

83 770 Bend 5'8" APIT 360 360

84 780 6'0" API 360 360 Y restraint
85 790 12'o" APIT 360 360 Anchor
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Anchors
(1b/inch) (in-1b/degq) Releases Anchor
Node KX/kx KY/ky KZ/kz KXX/kxx KYY/kyy KZZ/kzz X Y Z XXYYZZ In Pipe
10 Rigid Rigid Rigid Rigid Rigid Rigid GCsS
110 Rigid Rigid Rigid Rigid Rigid Rigid GCs
510 Rigid Rigid Rigid Rigid Rigid Rigid GCS
630 Rigid Rigid Rigid Rigid Rigid Rigid GCs
710 Rigid Rigid Rigid Rigid Rigid Rigid GCS
790 Rigid Rigid Rigid Rigid Rigid Rigid GCS
Bends
Bend Radius Thickness Bend Flex. Int. Angle Int. Angle
Node (inch) (inch) Matl Factor Node (deqg) Node (deqg)
20 81 L
40 81 L
140 54 L
150 54 L
180 54 L
230 48 U
560 48 )
690 48 U
720 54 L
740 54 L
770 54 L
Reducers
OoD1 Thkl 0OD2 Thk2 Cone Angle Knuc Delta
From To (inch) (inch) (inch) (inch) (deqg) kles (inch)
120 130 54 0.375 36 0.375
Restraints
Node X Y 7
50 Yes
70 Yes
80 Yes
90 Yes
160 Yes
170 Yes
190 Yes
200 Yes
220 Yes
240 Yes
260 Yes
280 Yes Yes
300 Yes
320 Yes
330 Yes Yes
350 Yes
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Restraints
Node X Y Z
370 Yes
390 Yes Yes
410 Yes
430 Yes
450 Yes Yes
470 Yes
490 Yes
530 Yes
550 Yes
570 Yes
590 Yes
610 Yes Yes
650 Yes Yes
670 Yes
680 Yes
700 Yes
730 Yes
780 Yes

Pipe material API: API 5L Grade B

Density = 0.283 (1lb/in3), Nu = 0.300, Joint factor = 1.00, Type = CS
Yield strength = 35000 (psi)

Temp E Alpha Allowable
(F) (psi) (in/in/F) (psi)
-325 31.4E+6 5.00E-6 20000
-200 30.8E+6 5.35E-6 20000
-100 30.2E+6 5.65E-6 20000
70 29.5E+6 6.07E-6 20000
200 28.8E+6 6.38E-6 20000
300 28.3E+6 6.60E-6 20000
400 27.7E+6 6.82E-6 19900
500 27.3E+6 7.02E-6 19000
600 26.7E+6 7.23E-6 17900
650 26.1E+6 7.33E-6 17300
700 25.5E+6 7.44E-6 16700
750 24 .8E+6 7.54E-6 13900
800 24 .2E+6 7.65E-6 11400
850 23.3E+6 7.75E-6 8700
900 22 .4E+6 7.84E-6 5900
950 21.4E+6 7.91E-6 4000
1000 20.4E+6 7.97E-6 2500
1050 19.2E+6 8.05E-6 1600
1100 18.0E+6 8.12E-6 1000
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Sch

0.D.
(inch)

Thk Cor.A1 M

.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th
(%) (1b/ft3) (inch) (1lb/ft3) (inch)

Nominal
Name Dia.
361 36"
360 36"

(inch) (inch)
0.375 0
0.375 0
0.375 0
0.375 0
Load

Static seismic load:

X =-0.20, ¥ = -

Acceleration load combination = Square

X spectrum:
Y spectrum:
Z spectrum:

Mode sum =

Malta, NY b Factor
Malta, NY b Factor

Malta, NY b Factor =

SRSS

Directio

0.20, 2z = -0.20 (g's)
Root of Sum of Squares

1.0000
0.0430
1.0000

n sum = SRSS

r =
ion:

Pressure

0.60
X comp

(psf)

15
15
15
15

= 0.000, Y comp

= 0.000, Z comp = 1.000

Shape facto
Wind direct
Elevation

(feet)

0

15

30

45

60
Load T1
Name (F)
360 100
361 100
540 100
5471 100

ads
T3 P3 Specific Add.Wgt Wind
F) (psi) gravity (lb/ft) Load
Y
Y

From the Modal Analysis results shown below, it was noted that the CAEPIPE was able to extract 92
modes with highest frequency being 95.967 Hz.
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Frequency Period Participation factors Modal mass / Total mass
Mode (Hz) (sec) X Y Z X Y Z

1 1.875 0.5335 -5.7615 -0.0004 0.5255 0.0979 0.0000 0.0008
2 3.288 0.3041 -6.7721 -0.0000 0.0003 0.1353 0.0000 0.0000
3 5.971 0.1675 -4.1919 0.0000 0.0001 0.0518 0.0000 0.0000
4 6.147 0.1627 0.0909 -0.0000 =-0.1021 0.0000 0.0000 0.0000
5 7.800 0.1282 -0.4240 -0.0000 4.5032 0.0005 0.0000 0.0598
6 8.102 0.1234 0.0029 0.0001 0.3321 0.0000 0.0000 0.0003
7 9.933 0.1007 0.0861 -0.0000 -4.2655 0.0000 0.0000 0.0537
8 10.146 0.0986 -0.6501 0.0002 1.6688 0.0012 0.0000 0.0082
9 10.241 0.0976 -2.1689 =-0.0000 0.0048 0.0139 0.0000 0.0000
10 11.279 0.0887 3.2684 -0.0002 -7.9718 0.0315 0.0000 0.1874
11 11.628 0.0860 6.7199 -0.0002 5.8034 0.1332 0.0000 0.0993
12 13.116 0.0762 -0.0013 1.4576 -3.8221 0.0000 0.0063 0.0431
13 13.276 0.0753 2.6364 0.0000 -0.0001 0.0205 0.0000 0.0000
14 13.931 0.0718 3.3527 0.0030 -3.2879 0.0332 0.0000 0.0319
15 16.027 0.0624 -3.6866 0.0000 -0.3181 0.0401 0.0000 0.0003
16 16.038 0.0624 -2.9281 -0.0001 -0.7810 0.0253 0.0000 0.0018
17 17.802 0.0562 -1.8832 0.0179 2.3004 0.0105 0.0000 0.0156
18 21.780 0.0459 0.0000 2.7930 3.3879 0.0000 0.0230 0.0339
19 22.412 0.0446 -0.0006 =-3.2159 ~-1.3274 0.0000 0.0305 0.0052
20 22.683 0.0441 -0.3117 -0.0005 0.0747 0.0003 0.0000 0.0000
21 24.003 0.0417 -0.5955 =-0.0000 0.1696 0.0010 0.0000 0.0001
22 24.910 0.0401 2.7763 -0.0000 -0.0070 0.0227 0.0000 0.0000
23 26.421 0.0378 -0.2314 0.0001 0.1348 0.0002 0.0000 0.0001
24 27.698 0.0361 -1.3316 0.0000 -0.0002 0.0052 0.0000 0.0000
25 29.713 0.0337 -1.2585 =-0.0000 =-0.0049 0.0047 0.0000 0.0000
26 30.079 0.0332 -0.3437 0.0000 -0.1955 0.0003 0.0000 0.0001
27 30.146 0.0332 0.0215 -0.0001 0.3494 0.0000 0.0000 0.0004
28 31.946 0.0313 -0.6062 0.0012 -1.6290 0.0011 0.0000 0.0078
29 33.670 0.0297 0.9928 -0.0040 2.8297 0.0029 0.0000 0.0236
30 36.072 0.0277 0.0014 1.4997 -2.1277 0.0000 0.0066 0.0134
31 37.812 0.0264 -0.4989 -0.0074 2.1572 0.0007 0.0000 0.0137
32 39.097 0.0256 1.2371 -0.0000 -0.0086 0.0045 0.0000 0.0000
33 41.172 0.0243 -0.0001 1.2001 -6.2487 0.0000 0.0042 0.1152
34 41.250 0.0242 -0.3414 -0.0000 1.6185 0.0003 0.0000 0.0077
35 42.488 0.0235 0.7544 -0.0001 -0.0047 0.0017 0.0000 0.0000
36 43.804 0.0228 -0.4830 0.0108 1.2389 0.0007 0.0000 0.0045
37 46.065 0.0217 -0.0011 0.0686 -0.0001 0.0000 0.0000 0.0000
38 46.766 0.0214 -0.0098 -0.5622 -0.0023 0.0000 0.0009 0.0000
39 47.504 0.0211 -0.2337 -0.0029 -0.2475 0.0002 0.0000 0.0002
40 49.063 0.0204 0.0015 0.3511 0.0007 0.0000 0.0004 0.0000
41 49.295 0.0203 -0.0000 -1.0018 ~-0.0000 0.0000 0.0030 0.0000
42 49.985 0.0200 1.3732 -0.0000 -1.3809 0.0056 0.0000 0.0056
43 50.052 0.0200 -0.1938 0.0000 -1.9635 0.0001 0.0000 0.0114
44 52.178 0.0192 -0.9811 -0.0281 -0.6345 0.0028 0.0000 0.0012
45 52.335 0.0191 0.0000 -0.8918 -0.0000 0.0000 0.0023 0.0000
46 53.313 0.0188 -0.0715 -1.0283 -0.1169 0.0000 0.0031 0.0000
47 53.496 0.0187 -1.0974 -0.0751 -1.8548 0.0036 0.0000 0.0101
48 54.481 0.0184 0.0407 -1.8917 0.0845 0.0000 0.0106 0.0000
49 56.408 0.0177 0.4159 -1.3502 0.0358 0.0005 0.0054 0.0000
50 56.457 0.0177 2.6140 0.2176 -0.1253 0.0202 0.0001 0.0000
51 56.920 0.0176 1.8036 0.0012 0.0177 0.0096 0.0000 0.0000
52 57.929 0.0173 -0.2764 -0.0033 -0.0311 0.0002 0.0000 0.0000
53 58.372 0.0171 -1.1204 0.0366 0.3623 0.0037 0.0000 0.0004
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Frequency Period Participation factors Modal mass / Total mass
Mode (Hz) (sec) X Y Z X Y Z

54 58.736 0.0170 0.0013 -0.4068 0.0005 0.0000 0.0005 0.0000
55 62.338 0.0160 -0.0004 1.7473 2.3502 0.0000 0.0090 0.0163
56 63.166 0.0158 1.4680 0.0042 1.3132 0.0064 0.0000 0.0051
57 63.180 0.0158 1.1531 0.0001 -1.1840 0.0039 0.0000 0.0041
58 63.512 0.0157 0.0000 -0.1612 0.0000 0.0000 0.0001 0.0000
59 64.003 0.0156 -0.0020 -0.5988 0.0007 0.0000 0.0011 0.0000
60 64.339 0.0155 -0.0000 -1.1254 0.0000 0.0000 0.0037 0.0000
61 65.107 0.0154 -1.0551 -0.0210 1.1888 0.0033 0.0000 0.0042
62 65.192 0.0153 0.0016 0.3043 0.5961 0.0000 0.0003 0.0010
63 65.893 0.0152 -0.0078 =-0.0572 0.0105 0.0000 0.0000 0.0000
64 69.245 0.0144 -0.0005 =-0.9214 0.0006 0.0000 0.0025 0.0000
65 70.044 0.0143 -2.3140 -0.0000 ~-1.0324 0.0158 0.0000 0.0031
66 70.911 0.0141 -3.2315 =-0.0000 -1.9392 0.0308 0.0000 0.0111
67 73.355 0.0136 -0.9182 0.2454 0.2391 0.0025 0.0002 0.0002
68 73.445 0.0136 -0.0085 1.5999 0.0018 0.0000 0.0075 0.0000
69 74.015 0.0135 0.0021 1.9142 0.0703 0.0000 0.0108 0.0000
70 74.156 0.0135 -0.0000 2.9214 -0.0000 0.0000 0.0252 0.0000
71 74.905 0.0134 0.0017 -3.8949 0.0017 0.0000 0.0447 0.0000
72 76.249 0.0131 -0.1108 0.0489 0.0287 0.0000 0.0000 0.0000
73 76.553 0.0131 0.0001 1.4453 0.0002 0.0000 0.0062 0.0000
74 76.599 0.0131 0.0000 3.2442 0.0000 0.0000 0.0310 0.0000
75 78.151 0.0128 -0.0001 -5.7802 -0.0001 0.0000 0.0985 0.0000
76 78.399 0.0128 0.1428 -1.8259 0.2005 0.0001 0.0098 0.0001
77 79.572 0.0126 -0.0000 -3.1388 -0.0000 0.0000 0.0291 0.0000
78 80.352 0.0124 -0.0611 -0.0303 0.0321 0.0000 0.0000 0.0000
79 80.590 0.0124 -0.4718 0.0055 -0.0030 0.0007 0.0000 0.0000
80 81.366 0.0123 0.0014 -1.7246 1.7171 0.0000 0.0088 0.0087
81 81.537 0.0123 -0.6787 0.0000 2.6001 0.0014 0.0000 0.0199
82 83.538 0.0120 2.6049 -0.0000 0.2580 0.0200 0.0000 0.0002
83 83.555 0.0120 0.0186 0.0064 -0.0224 0.0000 0.0000 0.0000
84 85.143 0.0117 -0.9456 0.0093 -0.0136 0.0026 0.0000 0.0000
85 86.260 0.0116 -0.0033 -0.7082 1.6260 0.0000 0.0015 0.0078
86 86.553 0.0116 0.1187 -0.0708 1.3196 0.0000 0.0000 0.0051
87 87.389 0.0114 -0.0038 =-0.2207 -0.7108 0.0000 0.0001 0.0015
88 87.678 0.0114 1.8995 -0.0000 -1.1843 0.0106 0.0000 0.0041
89 90.219 0.0111 -0.3088 =-0.2777 =-0.2039 0.0003 0.0002 0.0001
90 93.121 0.0107 -0.5735 -0.1326 0.4279 0.0010 0.0001 0.0005
91 95.224 0.0105 0.0000 4.5908 0.5409 0.0000 0.0622 0.0009
92 95.967 0.0104 0.7252 -0.0000 -0.6981 0.0016 0.0000 0.0014

Now, the original model shown above was refined through the feature Layout window > Edit > Refine
Nodal Mesh. The Mass modeling frequency was set to 110 Hz for refining the mesh for “Dynamic
Analysis” as shown below.

Refine Modal Mesh for o

" Buried Piping

* Dynaric Analysis

Maszz Modeling Frequency [Hz) (110

10



The resulting refined model with additional mass points added by CAEPIPE is shown in the snap shots
below.

K Caepipe: Graphics - [MWZAnder.mod (C:\Temp\Refined)] - x
File View Options Window Help

QA0

K Caepipe: Graphics - [MWZAnder.mod (C:\Temp\Refined)] - x
File View Options Window Help

QA0
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H4 Cacpipe: Graphics - [MWZAndermod (C:\Temp\Refined)] - x
File View Options Window Help

HE @&/ O

K Caepipe: Graphics - [MWZAnder.mod (C:\Temp\Refined)] - x
File View Options Window Help

Modal analysis was then performed using CAEPIPE for the refined model (with additional mass points
automatically added) for mass modeling frequency 110 Hz and found that the CAEPIPE was able to
extract all the modes below the cut-off frequency 110 Hz specified in the analysis options. Please see the
modal analysis results obtained from CAEPIPE shown below.

12
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Frequency Period Participation factors Modal mass / Total mass
Mode (Hz) (sec) X Y Z X Y Z

1 1.755 0.5698 -5.7696 -0.0003 0.5155 0.0982 0.0000 0.0008
2 2.855 0.3502 6.7662 0.0000 -0.0002 0.1350 0.0000 0.0000
3 5.521 0.1811 -4.1344 0.0000 -0.0001 0.0504 0.0000 0.0000
4 6.151 0.1626 0.0878 -0.0000 -0.1088 0.0000 0.0000 0.0000
5 7.722 0.1295 0.4309 0.0000 -4.5502 0.0005 0.0000 0.0611
6 8.119 0.1232 0.0315 0.0001 0.3840 0.0000 0.0000 0.0004
7 9.824 0.1018 0.0839 -0.0000 -4.3165 0.0000 0.0000 0.0550
8 10.063 0.0994 2.3014 0.0000 0.0054 0.0156 0.0000 0.0000
9 10.134 0.0987 -0.6185 0.0003 2.3174 0.0011 0.0000 0.0158
10 11.111 0.0900 2.0288 0.0003 -8.3004 0.0121 0.0000 0.2032
11 11.613 0.0861 -7.1492 0.0006 -4.4135 0.1508 0.0000 0.0575
12 12.635 0.0791 -0.0006 1.5513 -3.8503 0.0000 0.0071 0.0437
13 13.233 0.0756 2.6877 0.0000 -0.0007 0.0213 0.0000 0.0000
14 13.640 0.0733 2.9690 0.0034 -4.0182 0.0260 0.0000 0.0476
15 15.725 0.0636 3.7891 -0.0000 0.34098 0.0423 0.0000 0.0004
16 15.805 0.0633 3.1354 0.0024 0.9356 0.0290 0.0000 0.0026
17 16.409 0.0609 2.2658 -0.0169 -2.5046 0.0151 0.0000 0.0185
18 17.349 0.0576 -0.0000 =-2.7191 -3.1311 0.0000 0.0218 0.0289
19 20.661 0.0484 0.0007 3.2479 1.4079 0.0000 0.0311 0.0058
20 22.737 0.0440 0.2479 0.0001 -0.0877 0.0002 0.0000 0.0000
21 23.733 0.0421 0.7055 -0.0000 -0.0963 0.0015 0.0000 0.0000
22 23.782 0.0420 -2.9878 0.0000 0.0053 0.0263 0.0000 0.0000
23 26.507 0.0377 0.1027 0.0005 -0.1910 0.0000 0.0000 0.0001
24 27.187 0.0368 -0.6336 0.0000 -0.0045 0.0012 0.0000 0.0000
25 29.021 0.0345 -1.1191 0.0000 0.0002 0.0037 0.0000 0.0000
26 29.061 0.0344 0.3323 -0.0000 0.1679 0.0003 0.0000 0.0001
27 30.289 0.0330 -0.4261 0.0036 -1.0079 0.0005 0.0000 0.0030
28 31.215 0.0320 1.0457 -0.0087 2.3123 0.0032 0.0000 0.0158
29 33.583 0.0298 0.4478 -0.0064 1.5750 0.0006 0.0000 0.0073
30 36.362 0.0275 -1.1690 0.0000 -0.0052 0.0040 0.0000 0.0000
31 37.505 0.0267 -0.0033 1.4151 -2.1430 0.0000 0.0059 0.0135
32 37.885 0.0264 0.4183 0.0121 -2.4989 0.0005 0.0000 0.0184
33 40.194 0.0249 0.1951 -0.0000 -1.5005 0.0001 0.0000 0.0066
34 40.968 0.0244 0.0001 -1.1979 6.4128 0.0000 0.0042 0.1213
35 43.038 0.0232 0.3511 -0.0019 -1.2983 0.0004 0.0000 0.0050
36 43.372 0.0231 -0.4795 0.0000 -0.0105 0.0007 0.0000 0.0000
37 46.870 0.0213 0.0021 -0.0008 0.0010 0.0000 0.0000 0.0000
38 47.541 0.0210 -0.0144 -0.7462 -0.0080 0.0000 0.0016 0.0000
39 48.377 0.0207 -0.2963 -0.0021 -0.3487 0.0003 0.0000 0.0004
40 50.010 0.0200 -0.4830 0.0001 -1.8955 0.0007 0.0000 0.0106
41 50.132 0.0199 -0.0043 -0.3850 -0.0040 0.0000 0.0004 0.0000
42 50.285 0.0199 0.0000 1.2526 0.0000 0.0000 0.0046 0.0000
43 51.219 0.0195 1.2828 0.0000 -1.6462 0.0049 0.0000 0.0080
44 51.778 0.0193 1.4654 0.0565 1.8643 0.0063 0.0000 0.0103
45 53.561 0.0187 0.0000 -1.1367 =-0.0000 0.0000 0.0038 0.0000
46 53.672 0.0186 -0.1396 0.0329 0.4238 0.0001 0.0000 0.0005
47 54.731 0.0183 0.0027 -1.2178 0.0180 0.0000 0.0044 0.0000
48 56.221 0.0178 -0.0024 =-2.0037 0.0429 0.0000 0.0118 0.0000
49 57.051 0.0175 -1.6501 -0.0050 -0.0543 0.0080 0.0000 0.0000
50 57.365 0.0174 -0.2648 -0.0208 0.4221 0.0002 0.0000 0.0005
51 58.161 0.0172 -0.0620 =-1.7053 0.0076 0.0000 0.0086 0.0000
52 58.480 0.0171 -2.8218 0.0672 0.2197 0.0235 0.0000 0.0001
53 59.590 0.0168 0.0011 -1.6797 =-2.3900 0.0000 0.0083 0.0168

13



Caepipe dynamic model refined Page 2

Version 7.60 May 30,2016
Frequency Period Participation factors Modal mass / Total mass
Mode (Hz) (sec) X Y Z X Y Z

54 59.697 0.0168 1.3631 -0.0003 -0.0002 0.0055 0.0000 0.0000
55 60.969 0.0164 -0.0001 1.4746 0.5326 0.0000 0.0064 0.0008
56 61.166 0.0163 -0.0003 0.3240 -0.0009 0.0000 0.0003 0.0000
57 63.791 0.0157 1.1014 -0.0167 1.6815 0.0036 0.0000 0.0083
58 65.476 0.0153 0.0000 -0.0239 -0.0000 0.0000 0.0000 0.0000
59 66.097 0.0151 -2.0302 -0.0513 0.5933 0.0122 0.0000 0.0010
60 66.996 0.0149 0.6629 0.0000 -1.1896 0.0013 0.0000 0.0042
61 67.413 0.0148 0.0051 -0.4949 -0.0031 0.0000 0.0007 0.0000
62 67.702 0.0148 0.0000 -1.4164 -0.0000 0.0000 0.0059 0.0000
63 69.973 0.0143 -0.0065 -0.2969 0.0052 0.0000 0.0003 0.0000
64 70.117 0.0143 0.0002 -2.2385 0.7487 0.0000 0.0148 0.0017
65 70.175 0.0143 -2.4152 -0.0000 -0.9261 0.0172 0.0000 0.0025
66 74.234 0.0135 3.4185 0.0003 1.5639 0.0345 0.0000 0.0072
67 74.560 0.0134 0.0042 1.0701 -0.0017 0.0000 0.0034 0.0000
68 74.843 0.0134 -1.3329 0.8236 0.1534 0.0052 0.0020 0.0001
69 76.927 0.0130 -0.4107 -1.5744 0.2386 0.0005 0.0073 0.0002
70 78.576 0.0127 -0.1023 0.0017 -0.0013 0.0000 0.0000 0.0000
71 80.082 0.0125 0.0006 -0.5746 1.6438 0.0000 0.0010 0.0080
72 80.485 0.0124 0.0002 -2.1498 0.0002 0.0000 0.0136 0.0000
73 81.701 0.0122 -0.2466 -0.0537 0.0757 0.0002 0.0000 0.0000
74 81.749 0.0122 -0.0002 3.4973 0.0000 0.0000 0.0361 0.0000
75 82.787 0.0121 -0.0004 4.3124 -0.0023 0.0000 0.0549 0.0000
76 84.316 0.0119 1.6969 0000 -3.1197 0.0085 0.0000 0.0287
77 85.065 0.0118 -0.0026 -0.4712 0.8256 0.0000 0.0007 0.0020
78 85.440 0 0.0000 0.0423 0.0000

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0

0 0. 0 0
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Annexure B
Verification for Export of Local Element Forces and Moments

contributed by each Mode
participating in Response Spectrum Analysis
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Verification for Export of Local Element Forces and Moments contributed by each
Mode participating in Response Spectrum Analysis

A new feature is added in CAEPIPE Version 7.60 to automatically export in .csv format element forces
and moments in Local coordinate system contributed by each mode participating in Response Spectrum.
These will be exported only when the option “Analyze” is selected through Layout Window > File >
Analyze. CAEPIPE will name the .CSV file automatically by appending “_MFM” with the model name
specified.

The above implementation is verified by combining the forces and moments manually for each Mode Sum
manually (using Excel) and compared against the CAEPIPE element forces and moments for Response
Spectrum load case for the models described below along with their respective path shown in bracket.

1. RespSpectrumSRSS NoMissMass_NoSeisDisp.mod (.\Verification\MFM\Model-1)
RespSpectrumSRSS_WithMissMass_NoSeisDisp.mod (.\Verification\MFM\Model-2)
RespSpectrumSRSS_WithMissMass_WithSeisDisp.mod (.\Verification\MFM\Model-3)
RespSpectrumCSM_NoMissMass_NoSeisDisp.mod (.\Verification\MFM\Model-4)
RespSpectrumCSM_WithMissMass_WithSeisDisp.mod (.\Verification\MFM\Model-5)
RespSpectrumABSS_NoMissMass_NoSeisDisp.mod (.\Verification \MFM\Model-6)

o gk wnN

Model 1: RespSpectrumSRSS_NoMissMass_NoSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum = SRSS.
In addition, the option “Include Missing Mass” was turned “OFF” and NO Seismic Displacements were
entered at Anchor Nodes.

File “RespSpectrumSRSS_NoMissMass_NoSeisDisp_ MFM.csv” contains the element forces and
moments for each mode exported from CAEPIPE. The element forces and moments are then manually
combined and compared against the CAEPIPE element forces and moments for Response Spectrum load
case. The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumSRSS_NoMissMass_NoSeisDisp_MFM.xIsx for details.
Model 2: RespSpectrumSRSS_WithMissMass_NoSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum = SRSS.
In addition, the option “Include Missing Mass” was turned “ON” and NO Seismic Displacements were
entered at Anchor Nodes.

File “RespSpectrumSRSS_WithMissMass_NoSeisDisp_ MFM.csv” contains the element forces and
moments for each mode exported from CAEPIPE. The element forces and moments are then manually
combined and compared against the CAEPIPE element forces and moments for Response Spectrum load
case. The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumSRSS_WithMissMass_NoSeisDisp_MFM.xIsx for details.
Model 3: RespSpectrumSRSS_WithMissMass_WithSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum = SRSS.
In addition, the option “Include Missing Mass” was turned “ON” and Seismic Displacements were
entered as given below.

Seismic Displacements at Anchor @ Node 10: X =Y = 0.5 inch & Anchor @ Node 90: X =Y =-0.5inch

File “RespSpectrumSRSS_WithMissMass_WithSeisDisp_MFM.csv”’ contains the element forces and
moments for each mode exported from CAEPIPE. The element forces and moments are then manually
combined and compared against the CAEPIPE element forces and moments for Response Spectrum load
case. The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumSRSS_WithMissMass_WithSeisDisp_MFM.xIsx for details.
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Model 4: RespSpectrumCSM_NoMissMass_NoSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum = Closely
Spaced. In addition, the option “Include Missing Mass” was turned “OFF” and NO Seismic
Displacements were entered.

File “RespSpectrumCSM_NoMissMass_NoSeisDisp_MFM.csv” contains the element forces and moments
for each mode exported from CAEPIPE. The element forces and moments are then manually combined
and compared against the CAEPIPE element forces and moments for Response Spectrum load case.
The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumCSM_NoMissMass_NoSeisDisp_MFM.xIsx for details.
Model 5: RespSpectrumCSM_WithMissMass_WithSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum = Closely
Spaced. In addition, the option “Include Missing Mass” was turned “On” and Seismic Displacements
were entered as given below.

Seismic Displacements at Anchor @ Node 10: X =Y = 0.5 inch & Anchor @ Node 90: X =Y =-0.5inch

File “RespSpectrumCSM_WithMissMass_WithSeisDisp_ MFM.csv” contains the element forces and
moments for each mode exported from CAEPIPE. The element forces and moments are then manually
combined and compared against the CAEPIPE element forces and moments for Response Spectrum load
case. The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumCSM_WithMissMass_WithSeisDisp_MFM.xIsx for details.
Model 6: RespSpectrumABSS_NoMissMass_NoSeisDisp.mod

In this model, Response Spectrum load is defined and included in the analysis with Mode Sum =
Absolute. In addition, the option “Include Missing Mass” was turned “OFF” and No Seismic
Displacements were entered at Anchor Nodes.

File “RespSpectrumABSS_NoMissMass_NoSeisDisp_ MFM.csv” contains the element forces and
moments for each mode exported from CAEPIPE. The element forces and moments are then manually
combined and compared against the CAEPIPE element forces and moments for Response Spectrum load
case. The manually combined results are found to be identical to CAEPIPE computed results.

Please see the file RespSpectrumCSM_WithMissMass_WithSeisDisp_MFM.xIsx for details.

From the comparison results of the above models, it was noted that the values obtained by
manual combinations are exactly matching the CAEPIPE computed element forces and moments
for Response Spectrum loadings.

CAEPIPE Input file for Model “Model 1 - RespSpectrumSRSS_NoMissMass_NoSeisDisp.mod” along
with CAEPIPE Response Spectrum Element Forces and Moments results as well as the Forces and
Moments manually combined from .CSV results is given below.

For rest of the models, CAEPIPE Response Spectrum Element Forces and Moments and the Forces and
Moments manually combined from .csv results are presented in this section.

Similar verification is also carried out for a complex model (BIGMODEL_SRSS_MM_SD.mod — model
with 650+ elements). The CAEPIPE input file, results file, modal element forces and moments output file
and the modal element forces and moments manually combined using excel are available in the folder
“\Verification\MFM\Big Model” for reference. As the reports run into a few hundred pages (425+), they are
not presented in this section.
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Caepipe RespSpectrumSRSS NoMissMass NoSeisDisp Page 1
Version 7.60 Verification of Modal Forces and Moments Jul 14,2016

Piping code = B31.1 (2014)

Do not use liberal allowable stresses
Do not include axial force in stress calculations
Reference temperature = 40 (F)

Number of thermal cycles = 7000

Number of thermal loads =1

Thermal = Operating - Sustained

Use modulus at reference temperature
Include hanger stiffness

Include Bourdon effect

Use pressure correction for bends
Pressure stress = PD / 4t

Peak pressure factor = 1.00

Cut off frequency = 100 Hz

Number of modes = 5

Do not include missing mass correction
Use friction in dynamic analysis
Vertical direction =Y

# Node Type DX (ft'in") DY (ft'in") DZ(ft'in") Mat Sec Load Data

1
2
3 Spectrum = SpecXYZ

4 Mode Sum Combination = SRSS

5 Direction Sum Combination = SRSS
6 Include Missing Mass = No

7 Seismic Displacements at Anchors
8 Node 10: X =Y = Z = 0.0 inch

9 Node 90: X =Y =2 = 0.0 inch

10

11 10 From Anchor

12 20 Bend 1'o"” API 541 541

13 30 -20'0" API 5471 5471

14 40 Bend -10'9" API 541 5471

15 50 9ro" API 541 541

16 60 Valve 2'o" APIT 540 540

17 70 6'oO" API 540 540

18 80 Valve 2'o" API 540 540

19 90 9ro" API 540 540 Anchor

Anchors
(1b/inch) (in-1b/degq) Releases Anchor

Node KX/kx KY/ky Kz/kz KXX/kxx KYY/kyy KZZ/kzz X Y Z XXYYZZ In Pipe
10 Rigid Rigid Rigid Rigid Rigid Rigid GCS
90 Rigid Rigid Rigid Rigid Rigid Rigid GCs
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Caepipe RespSpectrumSRSS NoMissMass NoSeisDisp Page 2

Version 7.60 Verification of Modal Forces and Moments Jul 14,2016
Bends
Bend Radius Thickness Bend Flex. Int. Angle Int. Angle
Node (inch) (inch) Matl Factor Node (deqg) Node (deg)
20 81 L
40 81 L
Valves
Weight Length Thick Insul Add Wght DX DY DZ
From To (1b) (inch) X Wgt X (1lb) (inch) (inch) (inch)
50 60 1000 3.00 1.75
70 80 1000 3.00 1.75

Pipe material API: API 5L Grade B

Density = 0.283 (lb/in3), Nu = 0.300, Joint factor = 1.00, Type = CS

Temp E Alpha Allowable
(F) (psi) (in/in/F) (psi)
-325 31.4E+6 5.00E-6 20000
-200 30.8E+6 5.35E-6 20000
-100 30.2E+6 5.65E-6 20000
70 29.5E+6 6.07E-6 20000
200 28.8E+6 6.38E-6 20000
300 28.3E+6 6.60E-6 20000
400 27.7E+6 6.82E-6 19900
500 27.3E+6 7.02E-6 19000
600 26.7E+6 7.23E-6 17900
650 26.1E+6 7.33E-6 17300
700 25.5E+6 7.44E-6 16700
750 24 .8E+6 7.54E-6 13900
800 24 .2E+6 7.65E-6 11400
850 23.3E+6 7.75E-6 8700
900 22 .4E+6 7.84E-6 5900
950 21.4E+6 7.91E-6 4000
1000 20.4E+6 7.97E-6 2500
1050 19.2E+6 8.05E-6 1600
1100 18.0E+6 8.12E-6 1000

Nominal 0.D. Thk Cor.Al M.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th
Name Dia. Sch (inch) (inch) (inch) (%) (lb/ft3) (inch) (1b/ft3) (inch)
361 36" STD 36 0.375 0.075 0.0 13 2
360 36" STD 36 0.375 0.075 0.0 13 2.5
540 Non Std 54 0.375 0.075 0.0 13 2.5
541 Non Std 54 0.375 0.075 0.0 13 2
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Caepipe RespSpectrumSRSS NoMissMass NoSeisDisp Page 3

Version 7.60 Verification of Modal Forces and Moments Jul 14,2016
Loads
X spectrum: SpecXYZ Factor = 1.0000
Y spectrum: SpecXYZ Factor = 1.0000
7 spectrum: SpecXYZ Factor = 1.0000
Mode sum = SRSS Direction sum = SRSS
Pipe Loads
Load T1 Pl T2 P2 T3 P3 Specific Add.Wgt Wind
Name (F) (psi) (F) (psi) (F) (psi) gravity (lb/ft) Load
360 100 125 1.000 77.2 Y
361 100 125 1.000
540 100 125 1.000 111.1 Y
541 100 125 1.000

Frequency Displacement
(Hz) (inch)

8

0.
30 0

2
.2

20



Local & Global Element Forces and Moments for Response Spectrum from
CAEPIPE

Caepipe RespSpectrumSRSS NoMissMass NoSeisDisp Page 4
Version 7.60 Verification of Modal Forces and Moments Jul 14,2016

Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 39153 65201 36207 158859 273116 493301 18158
20A 39153 65201 36207 158859 129233 229101 11228
20A 38957 62931 34542 158859 129233 229101 3.31 21220
20B 62931 38957 34542 139680 126821 169876 3.31 16525
20B 45042 14930 24342 139680 169876 126821 9338
30 45042 14930 24342 139680 367995 123498 10740
30 33037 13589 20162 139680 367995 123498 10740
40A 33037 13589 20162 139680 291622 103656 9439
40A 25357 55799 26790 139680 103656 291622 3.31 16774
40B 55799 25357 26790 117501 100429 249924 3.31 15090
40B 56897 8965 20867 117501 100429 249924 8761
50 56897 8965 20867 117501 118001 235518 8628
60 57946 39621 28915 117501 139344 202524 8510
70 57946 39621 28915 117501 253383 128460 9896
80 58894 63171 40310 117501 308558 200221 11476
90 58894 63171 40310 117501 632830 741756 23014

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 57271 20158 22496 117501 118001 235518
60 57271 20158 22496 117501 139344 202524
70 Valve 58365 51089 34094 117501 253383 128460
80 58365 51089 34094 117501 308558 200221

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 36207 65201 39153 493301 273116 158859
20A 36207 65201 39153 229101 129233 158859
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Caepipe RespSpectrumSRSS NoMissMass NoSeisDisp Page 5
Version 7.60 Verification of Modal Forces and Moments Jul 14,2016

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
20A 34542 62931 38957 229101 129233 158859
20B 34542 62931 38957 169876 139680 126821
20B 14930 45042 24342 169876 139680 126821
30 14930 45042 24342 367995 139680 123498
30 13589 33037 20162 367995 139680 123498
40A 13589 33037 20162 291622 139680 103656
40A 26790 25357 55799 291622 139680 103656
40B 26790 25357 55799 249924 100429 117501
40B 20867 8965 56897 249924 100429 117501
50 20867 8965 56897 235518 118001 117501
60 28915 39621 57946 202524 139344 117501
70 28915 39621 57946 128460 253383 117501
80 40310 63171 58894 200221 308558 117501
90 40310 63171 58894 741756 632830 117501

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 22496 20158 57271 235518 118001 117501
60 22496 20158 57271 202524 139344 117501
70 Valve 34094 51089 58365 128460 253383 117501
80 34094 51089 58365 200221 308558 117501
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Local Element Forces and Moment results obtained by combining forces and

moments from each mode using SRSS

Combined Local Element Forces and Moments using SRSS

Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)

10 39153 65201 36207 158859 273116 493301
20A 39153 65201 36207 158859 129233 229101
20A | Bend 38957 62931 34542 158859 129233 229101
208B 62931 38957 34542 139680 126821 169876
20B 45042 14930 24343 139680 169876 126821

30 45042 14930 24343 139680 367995 123498

30 33037 13589 20162 139680 367995 123498
40A 33037 13589 20162 139680 291622 103656
40A | Bend 25357 55799 26790 139680 103656 291622
40B 55799 25357 26790 117501 100429 249924
40B 56897 8965 20867 117501 100429 249924

50 56897 8965 20867 117501 118001 235518

50 | Valve 57271 20158 22496 117501 118001 235518

60 57271 20158 22496 117501 139344 202524

60 57946 39621 28915 117501 139344 202524

70 57946 39621 28915 117501 253383 128460

70 | Valve 58365 51089 34094 117501 253383 128460

80 58365 51089 34094 117501 308558 200221

80 58894 63171 40310 117501 308558 200221

90 58894 63171 40310 117501 632830 741756
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Forces and

Transformation of Local Element Forces and Moments to Global
Moments
Transformation to Global Element Forces and Moments
Node Type FX FY Fz MX MY Mz
(Ib) (Ib) (Ib) (ft-1b) (ft-1b) (ft-1b)
10 36207 65201 39153 493301 273116 158859
20A 36207 65201 39153 229101 129233 158859
20A | Bend 34542 62931 38957 229101 129233 158859
20B 34542 62931 38957 169876 139680 126821
20B 14930 45042 24343 169876 139680 126821
30 14930 45042 24343 367995 139680 123498
30 13589 33037 20162 367995 139680 123498
40A 13589 33037 20162 291622 139680 103656
40A | Bend 26790 25357 55799 291622 139680 103656
40B 26790 25357 55799 249924 100429 117501
40B 20867 8965 56897 249924 100429 117501
50 20867 8965 56897 235518 118001 117501
50 | Valve 22496 20158 57271 235518 118001 117501
60 22496 20158 57271 202524 139344 117501
60 28915 39621 57946 202524 139344 117501
70 28915 39621 57946 128460 253383 117501
70 | Valve 34094 51089 58365 128460 253383 117501
80 34094 51089 58365 200221 308558 117501
80 40310 63171 58894 200221 308558 117501
90 40310 63171 58894 741756 632830 117501
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Local Element Forces and Moments from .CSV file for each Mode

Modal Local Forces & Moments: Mode = 1; Frequency = 6.434 Hz

Node | Type | fx fy fz mx my mz

(Ib) (Ib) (Ib) (ft-1b) (ft-Ib) (ft-Ib)
10 0 -10641 108595.9 | 33473.79
20A 0 -10641 108595.9 | -11750.4
20A Bend 10566.63 | 108595.9 | 11750.42
208B 10566.63 | 83075.18 | -37271.1
20B -7473.5 83075.18 -37271.1
30 -7473.5 83075.18 61752.78
30 2485.93 83075.18 61752.78
40A 0 2485.93 83075.18 51809.06
40A Bend 12722.87 83075.18 -51809.1
408 12722.87 | 34070.34 | 2804.21
408 19977.83 | 34070.33 | 2804.21
50 19977.83 | 34070.33 | 47754.34
50 Valve 22374.04 | 34070.33 | 47754.34
60 22374.04 | 34070.33 | 92502.43
60 26211.24 | 34070.33 | 92502.43
70 26211.24 | 34070.33 | 249769.9
70 Valve 28168.48 | 34070.33 | 249769.9
80 0 28168.48 | 34070.33 | 306106.8
80 0 0 30118.99 | 34070.33 | 306106.8
90 0 0 30118.99 | 34070.33 | 577177.8
Modal Local Forces & Moments: Mode = 2; Frequency = 8.302 Hz
Node | Type | fx fy fz mx my mz

(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)
10 12180.86 | 45587.7 0 0 409591.7
20A 12180.86 | 45587.7 0 0 215844
20A Bend | 12159.84 | -44656.1 -215844
20B -44656.1 -12159.8 167663.3
20B -25920.2 3360.05 -167663
30 -25920.2 3360.05 -123143
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30 -12208.8 11896.31 -123143
40A -12208.8 11896.31 -75557.5
40A | Bend | -582 -17643 -75557.5
40B -17643 582 39604.56
40B -17759.8 -4969.95 39604.56
50 -17759.8 -4969.95 50786.95
50 Valve | -17799.5 -6794.15 50786.95
60 -17799.5 -6794.15 64375.24
60 -17871 -9697.85 64375.24
70 -17871 -9697.85 122562.3
70 Valve | -17915.1 -11163.9 122562.3
80 -17915.1 -11163.9 144890.1
80 -17970.9 -12618.6 0 144890.1
90 -17970.9 -12618.6 0 258457.6
Modal Local Forces & Moments: Mode = 3; Frequency = 13.461 Hz
Node | Type | fx fy fz mx my mz

(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)
10 0 -33841.1 97010.05 | 270865.2
20A 0 -33841.1 97010.05 | 127040.6
20A | Bend 32154.39 | 97010.05 | -127041
20B 32154.39 | 90001.5 120032.1
20B 8925.33 90001.5 120032.1
30 8925.33 90001.5 1771.47
30 11317.81 90001.5 1771.47
40A 11317.81 90001.5 -43499.8
40A | Bend 5896.04 90001.5 43499.78
408 0 5896.04 83298.08 | -50203.2
40B 0 2966.17 83298.09 | -50203.2
50 2966.17 83298.09 | -43529.3
50 Valve 2038.89 83298.09 | -43529.3
60 2038.89 83298.09 | -39451.5
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60 624.41 83298.09 | -39451.5
70 624.41 83298.09 | -35705.1
70 Valve -25.07 83298.09 | -35705.1
80 -25.07 83298.09 | -35755.2
80 0 0 -642 83298.09 | -35755.2
90 0 0 -642 83298.09 | -41533.2
Modal Local Forces & Moments: Mode = 4; Frequency = 14.598 Hz
Node | Type | fx fy fz mx my mz

(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)
10 37209.57 -46615.4 0 0 -274919
20A 37209.57 | -46615.4 0 0 -76803.5
20A | Bend | 37011.06 | 44340.69 76803.53
20B 44340.68 | -37011.1 27328.54
20B 36836.52 -24109.5 -27328.5
30 36836.52 -24109.5 -346779
30 30698.08 16278.78 -346779
40A 30698.08 16278.78 -281664
40A | Bend | 25350.07 | -52935.9 -281664
408 -52935.9 -25350.1 246766.1
40B -54054.1 7461.62 246766.1
50 -54054.1 7461.62 229977.4
50 Valve | -54435.3 18978.66 229977.4
60 -54435.3 18978.66 192020.1
60 -55121.4 38416.12 192020.1
70 -55121.4 38416.12 -38476.7
70 Valve | -55547.3 49854.82 -38476.7
80 -55547.3 49854.82 -138186
80 -56085.1 61898.24 0 -138186
90 -56085.1 61898.24 0 -695271
Modal Local Forces & Moments: Mode = 5; Frequency = 19.091 Hz
Node | Type | fx fy fz mx my mz

(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)
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10 7243.81 -63500.5 -10203.3

20A 7243.81 -63500.5 20582.93

20A Bend -6898.47 -63500.5 -20582.9

20B -6898.47 -67147.6 16935.89

20B 9348.74 -67147.6 16935.89
30 9348.74 -67147.6 -106935
30 -7099.32 -67147.6 -106935
40A -7099.32 -67147.6 -78537.7
40A Bend -22827.2 -67147.6 78537.69

408 -22827.2 -75545.6 -86935.7

40B -5244.73 -75545.6 -86935.7

50 -5244.73 -75545.6 -98736.4

50 Valve 1140.18 -75545.6 -98736.4

60 1140.18 -75545.6 -96456

60 12191.44 | -75545.6 -96456

70 12191.44 | -75545.6 -23307.4

70 Valve 19207.2 -75545.6 -23307.4

80 19207.2 -75545.6 15107.05

80 26782.85 | -75545.6 15107.05

90 26782.85 | -75545.6 256152.7
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Local & Global Element Forces and Moments for Response Spectrum from
CAEPIPE for Model 2: RespSpectrumSRSS_WithMissMass_NoSeisDisp.mod

Caepipe RespSpectrumSRSS WithMissMass NoSeisDisp Page 1
Version 7.60 Verification of Modal Forces and Moments Jul 14,2016

Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 132689 118937 70303 159112 363212 683223 21071
20A 132689 118937 70303 159112 130305 240453 11358
20A 78282 83746 34672 159112 130305 240453 3.31 21544
20B 83746 78282 34672 139726 127325 230779 3.31 18101
20B 49613 15034 27879 139726 230779 127325 9973
30 49613 15034 27879 139726 379204 124085 10886
30 38742 13590 24973 139726 379204 124085 10886
40A 38742 13590 24973 139726 298847 104373 9531
40A 46612 64462 26889 139726 104373 298847 3.31 17003
40B 64462 46612 26889 117549 102242 267522 3.31 15648
40B 101966 25798 25878 117549 102242 267522 8985
50 101966 25798 25878 117549 118984 270115 9046
60 157621 43752 34345 117549 148840 257247 9182
70 157621 43752 34345 117549 301564 234097 11209
80 250547 78402 52625 117549 348739 265998 12446
90 250547 78402 52625 117549 648558 783679 23613

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1Db) (ft-1b)
50 Valve 120517 29154 29139 117549 118984 270115
60 120517 29154 29139 117549 148840 257247
70 Valve 196540 53966 34097 117549 301564 234097
80 196540 53966 34097 117549 348739 265998

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 70303 118937 132689 683223 363212 159112
20A 70303 118937 132689 240453 130305 159112
20A 34672 83746 78282 240453 130305 159112
20B 34672 83746 78282 230779 139726 127325
20B 15034 49613 27879 230779 139726 127325
30 15034 49613 27879 379204 139726 124085
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
30 13590 38742 24973 379204 139726 124085
40A 13590 38742 24973 298847 139726 104373
40A 26889 46612 64462 298847 139726 104373
40B 26889 46612 64462 267522 102242 117549
40B 25878 25798 101966 267522 102242 117549
50 25878 25798 101966 270115 118984 117549
60 34345 43752 157621 257247 148840 117549
70 34345 43752 157621 234097 301564 117549
80 52625 78402 250547 265998 348739 117549
90 52625 78402 250547 783679 648558 117549

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 29139 29154 120517 270115 118984 117549
60 29139 29154 120517 257247 148840 117549
70 Valve 34097 53966 196540 234097 301564 117549
80 34097 53966 196540 265998 348739 117549
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Combination of Local Element Forces and Moments using SRSS

(Missing Mass included and Seismic Displacements NOT defined)
Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-1b) (ft-1b) (ft-1b)

10 132689 118937 | 70303 159112 363212 683223
20A 132689 118937 | 70303 159112 130305 240453
20A | Bend 78282 83746 | 34672 159112 130305 240453
208 83746 78282 | 34672 139726 127325 230779
20B 49613 15034 | 27879 139726 230779 127325

30 49613 15034 | 27879 139726 379204 124085

30 38742 13589 | 24973 139726 379204 124085
40A 38742 13589 | 24973 139726 298847 104373
40A | Bend 46612 64462 | 26889 139726 104373 298847
40B 64462 46612 | 26889 117549 102242 267522
408 101966 25798 | 25878 117549 102242 267522

50 101966 25798 | 25878 117549 118984 270115

50 | Valve 120517 29154 | 29139 117549 118984 270115

60 120517 29154 | 29139 117549 148840 257247

60 157621 43752 | 34345 117549 148840 257247

70 157621 43752 | 34345 117549 301564 234097

70 | Valve 196540 53966 | 34097 117549 301564 234097

80 196540 53966 | 34097 117549 348739 265998

80 250547 78402 | 52625 117549 348739 265998

90 250547 78402 | 52625 117549 648558 783679
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Transformation to Global Element Forces and Moments

(Missing Mass included and Seismic Displacements NOT defined)
Node | Type | FX FY FZ MX MY Mz
(Ib) (Ib) (Ib) (ft-1b) (ft-1b) (ft-1b)

10 70303 118937 132689 683223 363212 159112
20A 70303 118937 132689 240453 130305 159112
20A | Bend 34672 83746 78282 240453 130305 159112
20B 34672 83746 78282 230779 139726 127325
20B 15034 49613 27879 230779 139726 127325

30 15034 49613 27879 379204 139726 124085

30 13589 38742 24973 379204 139726 124085
40A 13589 38742 24973 298847 139726 104373
40A | Bend 26889 46612 64462 298847 139726 104373
40B 26889 46612 64462 267522 102242 117549
40B 25878 25798 101966 267522 102242 117549

50 25878 25798 101966 270115 118984 117549

50 | Valve 29139 29154 120517 270115 118984 117549

60 29139 29154 120517 257247 148840 117549

60 34345 43752 157621 257247 148840 117549

70 34345 43752 157621 234097 301564 117549

70 | Valve 34097 53966 196540 234097 301564 117549

80 34097 53966 196540 265998 348739 117549

80 52625 78402 250547 265998 348739 117549

90 52625 78402 250547 783679 648558 117549
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Local & Global Element Forces and Moments for Response Spectrum from CAEPIPE
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Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 148402 179646 76537 258926 436164 1137906 27575
20A 148402 179646 76537 258926 176764 437125 14518
20A 93996 144455 40906 258926 176764 437125 3.31 29398
20B 144455 93996 40906 144108 185063 337825 3.31 22106
20B 110322 21268 43592 144108 337825 185063 11584
30 110322 21268 43592 144108 480361 148942 12318
30 99451 19823 40686 144108 480361 148942 12318
40A 99451 19823 40686 144108 462859 154165 11852
40A 107321 80175 33123 144108 154165 462859 3.31 22771
40B 80175 107321 33123 209418 139937 407228 3.31 21649
40B 117679 86507 32112 209418 139937 407228 11400
50 117679 86507 32112 209418 170705 546415 13210
60 173335 104461 40578 209418 213028 654964 14893
70 173335 104461 40578 209418 403154 996067 21130
80 266261 139110 58859 209418 462796 1149385 23896
90 266261 139110 58859 209418 818717 2213445 42806

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1Db) (ft-1b)
50 Valve 136230 89863 35373 209418 170705 546415
60 136230 89863 35373 209418 213028 654964
70 Valve 212254 114675 40331 209418 403154 996067
80 212254 114675 40331 209418 462796 1149385

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 76537 179646 148402 1137906 436164 258926
20A 76537 179646 148402 437125 176764 258926
20A 40906 144455 93996 437125 176764 258926
20B 40906 144455 93996 337825 144108 185063
20B 21268 110322 43592 337825 144108 185063
30 21268 110322 43592 480361 144108 148942
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
30 19823 99451 40686 480361 144108 148942
40A 19823 99451 40686 462859 144108 154165
40A 33123 107321 80175 462859 144108 154165
40B 33123 107321 80175 407228 139937 209418
40B 32112 86507 117679 407228 139937 209418
50 32112 86507 117679 546415 170705 209418
60 40578 104461 173335 654964 213028 209418
70 40578 104461 173335 996067 403154 209418
80 58859 139110 266261 1149385 462796 209418
90 58859 139110 266261 2213445 818717 209418

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 35373 89863 136230 546415 170705 209418
60 35373 89863 136230 654964 213028 209418
70 Valve 40331 114675 212254 996067 403154 209418
80 40331 114675 212254 1149385 462796 209418
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Combination of Local Element Forces and Moments using SRSS
(Missing Mass included and Seismic Displacements defined)

Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-1b) (ft-Ib) (ft-1b)

10 148402 179646 76537 258926 436164 1137906
20A 148402 179646 76537 258926 176764 437124
20A | Bend 93996 144455 40906 258926 176764 437124
20B 144455 93996 40906 144108 185063 337825
20B 110322 21268 43592 144108 337825 185063

30 110322 21268 43592 144108 480361 148942

30 99451 19823 40686 144108 480361 148942
40A 99451 19823 40686 144108 462859 154165
40A | Bend 107321 80175 33123 144108 154165 462859
40B 80175 107321 33123 209418 139937 407228
408 117679 86507 32112 209418 139937 407228

50 117679 86507 32112 209418 170705 546415

50 | Valve 136230 89863 35373 209418 170705 546415

60 136230 89863 35373 209418 213028 654964

60 173335 104461 40578 209418 213028 654964

70 173335 104461 40578 209418 403154 996067

70 | Valve 212254 114674 40331 209418 403154 996067

80 212254 114674 40331 209418 462796 1149385

80 266261 139110 58859 209418 462796 1149385

90 266261 139110 58859 209418 818717 2213444
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Transformation to Global Element Forces and Moments

(Missing Mass included and Seismic Displacements defined)

Node | Type | FX FY Fz MX MY MZ
(Ib) (Ib) (Ib) (ft-Ib) (ft-Ib) (ft-Ib)

10 76537 | 179646 | 148402 1137906 | 436164 | 258926
20A 76537 | 179646 | 148402 437124 | 176764 | 258926
20A | Bend 40906 | 144455 93996 437124 | 176764 | 258926
208 40906 | 144455 93996 337825 | 144108 | 185063
20B 21268 | 110322 43592 337825 | 144108 | 185063

30 21268 110322 43592 480361 144108 148942

30 19823 99451 40686 480361 | 144108 | 148942
40A 19823 99451 40686 462859 | 144108 | 154165
40A | Bend 33123 107321 80175 462859 144108 154165
408B 33123 107321 80175 407228 139937 209418
40B 32112 86507 | 117679 407228 | 139937 | 209418

50 32112 86507 | 117679 546415 | 170705 | 209418

50 | valve | 35373 89863 | 136230 546415 | 170705 | 209418

60 35373 89863 | 136230 654964 | 213028 | 209418

60 40578 | 104461 | 173335 654964 | 213028 | 209418

70 40578 | 104461 | 173335 996067 | 403154 | 209418

70 | Valve | 40331 | 114674 | 212254 996067 | 403154 | 209418

80 40331 | 114674 | 212254 1149385 | 462796 | 209418

80 58859 | 139110 | 266261 1149385 | 462796 | 209418

90 58859 | 139110 | 266261 2213444 | 818717 | 209418
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Local & Global Element Forces and Moments for Response Spectrum from CAEPIPE
for Model 4: RespSpectrumCSM_NoMissMass_NoSeisDisp.mod
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Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 39153 65201 36207 158859 273116 493301 18158
20A 39153 65201 36207 158859 129233 229101 11228
20A 38957 62931 34542 158859 129233 229101 3.31 21220
20B 62931 38957 34542 139680 126821 169876 3.31 16525
20B 45042 14930 24342 139680 169876 126821 9338
30 45042 14930 24342 139680 367995 123498 10740
30 33037 13589 20162 139680 367995 123498 10740
40A 33037 13589 20162 139680 291622 103656 9439
40A 25357 55799 26790 139680 103656 291622 3.31 16774
40B 55799 25357 26790 117501 100429 249924 3.31 15090
40B 56897 8965 20867 117501 100429 249924 8761
50 56897 8965 20867 117501 118001 235518 8628
60 57946 39621 28915 117501 139344 202524 8510
70 57946 39621 28915 117501 253383 128460 9896
80 58894 63171 40310 117501 308558 200221 11476
90 58894 63171 40310 117501 632830 741756 23014

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1Db) (ft-1b)
50 Valve 57271 20158 22496 117501 118001 235518
60 57271 20158 22496 117501 139344 202524
70 Valve 58365 51089 34094 117501 253383 128460
80 58365 51089 34094 117501 308558 200221

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1lb) FZ (1lb) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 36207 65201 39153 493301 273116 158859
20A 36207 65201 39153 229101 129233 158859
20A 34542 62931 38957 229101 129233 158859
20B 34542 62931 38957 169876 139680 126821
20B 14930 45042 24342 169876 139680 126821
30 14930 45042 24342 367995 139680 123498
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
30 13589 33037 20162 367995 139680 123498
40A 13589 33037 20162 291622 139680 103656
40A 26790 25357 55799 291622 139680 103656
40B 26790 25357 55799 249924 100429 117501
40B 20867 8965 56897 249924 100429 117501
50 20867 8965 56897 235518 118001 117501
60 28915 39621 57946 202524 139344 117501
70 28915 39621 57946 128460 253383 117501
80 40310 63171 58894 200221 308558 117501
90 40310 63171 58894 741756 632830 117501

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 22496 20158 57271 235518 118001 117501
60 22496 20158 57271 202524 139344 117501
70 Valve 34094 51089 58365 128460 253383 117501
80 34094 51089 58365 200221 308558 117501

38



Combination of Local Element Forces and Moments using CSM

(Missing Mass NOT included and Seismic Displacements NOT defined)

Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-lb)

10 39153 65201 36207 158859 273116 493301
20A 39153 65201 36207 158859 129233 229101
20A | Bend 38957 62931 34542 158859 129233 229101
20B 62931 38957 34542 139680 126821 169876
20B 45042 14930 24343 139680 169876 126821

30 45042 14930 24343 139680 367995 123498

30 33037 13589 20162 139680 367995 123498
40A 33037 13589 20162 139680 291622 103656
40A | Bend 25357 55799 26790 139680 103656 291622
40B 55799 25357 26790 117501 100429 249924
408 56897 8965 20867 117501 100429 249924

50 56897 8965 20867 117501 118001 235518

50 | Valve 57271 20158 22496 117501 118001 235518

60 57271 20158 22496 117501 139344 202524

60 57946 39621 28915 117501 139344 202524

70 57946 39621 28915 117501 253383 128460

70 | Valve 58365 51089 34094 117501 253383 128460

80 58365 51089 34094 117501 308558 200221

80 58894 63171 40310 117501 308558 200221

90 58894 63171 40310 117501 632830 741756
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Transformation to Global Element Forces and Moments
(Missing Mass NOT included and Seismic Displacements NOT defined)

Node | Type FX FY Fz MX MY MZ
(Ib) (Ib) (Ib) (ft-Ib) (ft-Ib) (ft-Ib)

10 36207 65201 39153 493301 273116 158859
20A 36207 65201 39153 229101 129233 158859
20A | Bend 34542 62931 38957 229101 129233 158859
208 34542 62931 38957 169876 139680 126821
208 14930 45042 24343 169876 139680 126821

30 14930 45042 24343 367995 139680 123498

30 13589 33037 20162 367995 139680 123498
40A 13589 33037 20162 291622 139680 103656
40A | Bend 26790 25357 55799 291622 139680 103656
40B 26790 25357 55799 249924 100429 117501
40B 20867 8965 56897 249924 100429 117501

50 20867 8965 56897 235518 118001 117501

50 | Valve 22496 20158 57271 235518 118001 117501

60 22496 20158 57271 202524 139344 117501

60 28915 39621 57946 202524 139344 117501

70 28915 39621 57946 128460 253383 117501

70 | Valve 34094 51089 58365 128460 253383 117501

80 34094 51089 58365 200221 308558 117501

80 40310 63171 58894 200221 308558 117501

90 40310 63171 58894 741756 632830 117501
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Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 148402 179646 76537 258926 436164 1137906 27575
20A 148402 179646 76537 258926 176764 437125 14518
20A 93996 144455 40906 258926 176764 437125 3.31 29398
20B 144455 93996 40906 144108 185063 337825 3.31 22106
20B 110322 21268 43592 144108 337825 185063 11584
30 110322 21268 43592 144108 480361 148942 12318
30 99451 19823 40686 144108 480361 148942 12318
40A 99451 19823 40686 144108 462859 154165 11852
40A 107321 80175 33123 144108 154165 462859 3.31 22771
40B 80175 107321 33123 209418 139937 407228 3.31 21649
40B 117679 86507 32112 209418 139937 407228 11400
50 117679 86507 32112 209418 170705 546415 13210
60 173335 104461 40578 209418 213028 654964 14893
70 173335 104461 40578 209418 403154 996067 21130
80 266261 139110 58859 209418 462796 1149385 23896
90 266261 139110 58859 209418 818717 2213445 42806

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1Db) (ft-1b)
50 Valve 136230 89863 35373 209418 170705 546415
60 136230 89863 35373 209418 213028 654964
70 Valve 212254 114675 40331 209418 403154 996067
80 212254 114675 40331 209418 462796 1149385

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 76537 179646 148402 1137906 436164 258926
20A 76537 179646 148402 437125 176764 258926
20A 40906 144455 93996 437125 176764 258926
20B 40906 144455 93996 337825 144108 185063
20B 21268 110322 43592 337825 144108 185063
30 21268 110322 43592 480361 144108 148942
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
30 19823 99451 40686 480361 144108 148942
40A 19823 99451 40686 462859 144108 154165
40A 33123 107321 80175 462859 144108 154165
40B 33123 107321 80175 407228 139937 209418
40B 32112 86507 117679 407228 139937 209418
50 32112 86507 117679 546415 170705 209418
60 40578 104461 173335 654964 213028 209418
70 40578 104461 173335 996067 403154 209418
80 58859 139110 266261 1149385 462796 209418
90 58859 139110 266261 2213445 818717 209418

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 35373 89863 136230 546415 170705 209418
60 35373 89863 136230 654964 213028 209418
70 Valve 40331 114675 212254 996067 403154 209418
80 40331 114675 212254 1149385 462796 209418
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Combination of Local Element Forces and Moments using CSM

(Missing Mass included and Seismic Displacements defined)

Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-Ib)

10 148402 179646 76537 258926 436164 1137906
20A 148402 179646 76537 258926 176764 437124
20A | Bend 93996 144455 40906 258926 176764 437124
20B 144455 93996 40906 144108 185063 337825
20B 110322 21268 43592 144108 337825 185063

30 110322 21268 43592 144108 480361 148942

30 99451 19823 40686 144108 480361 148942
40A 99451 19823 40686 144108 462859 154165
40A | Bend 107321 80175 33123 144108 154165 462859
40B 80175 107321 33123 209418 139937 407228
408 117679 86507 32112 209418 139937 407228

50 117679 86507 32112 209418 170705 546415

50 | Valve 136230 89863 35373 209418 170705 546415

60 136230 89863 35373 209418 213028 654964

60 173335 104461 40578 209418 213028 654964

70 173335 104461 40578 209418 403154 996067

70 | Valve 212254 114674 40331 209418 403154 996067

80 212254 114674 40331 209418 462796 1149385

80 266261 139110 58859 209418 462796 1149385

90 266261 139110 58859 209418 818717 2213444
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Transformation to Global Element Forces and Moments

(Missing Mass included and Seismic Displacements defined)

Node | Type | FX FY Fz MX MY MZ
(Ib) (Ib) (Ib) (ft-Ib) (ft-Ib) (ft-Ib)

10 76537 | 179646 | 148402 1137906 | 436164 | 258926
20A 76537 | 179646 | 148402 437124 | 176764 | 258926
20A | Bend 40906 | 144455 93996 437124 | 176764 | 258926
208 40906 | 144455 93996 337825 | 144108 | 185063
20B 21268 | 110322 43592 337825 | 144108 | 185063

30 21268 110322 43592 480361 144108 148942

30 19823 99451 40686 480361 | 144108 | 148942
40A 19823 99451 40686 462859 | 144108 | 154165
40A | Bend 33123 107321 80175 462859 144108 154165
408B 33123 107321 80175 407228 139937 209418
40B 32112 86507 | 117679 407228 | 139937 | 209418

50 32112 86507 | 117679 546415 | 170705 | 209418

50 | valve | 35373 89863 | 136230 546415 | 170705 | 209418

60 35373 89863 | 136230 654964 | 213028 | 209418

60 40578 | 104461 | 173335 654964 | 213028 | 209418

70 40578 | 104461 | 173335 996067 | 403154 | 209418

70 | Valve | 40331 | 114674 | 212254 996067 | 403154 | 209418

80 40331 | 114674 | 212254 1149385 | 462796 | 209418

80 58859 | 139110 | 266261 1149385 | 462796 | 209418

90 58859 | 139110 | 266261 2213444 | 818717 | 209418
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Local & Global Element Forces and Moments for Response Spectrum from CAEPIPE
for Model 6: RespSpectrumABSS_NoMissMass_NoSeisDisp.mod

Caepipe RespSpectrumABSS NoMissMass NoSeisDisp Page 1
Version 7.60 Verification of Modal Forces and Moments Jul 14,2016

Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 49390 92203 51726 269107 314542 684511 21213
20A 49390 92203 51726 269107 159374 292648 12954
20A 49171 88997 49619 269107 159374 292648 3.31 25512
20B 88997 49171 49619 240224 174239 194992 3.31 20114
20B 62757 25748 27470 240224 194992 174239 10782
30 62757 25748 27470 240224 469922 170459 12767
30 42907 20903 28175 240224 469922 170459 12767
40A 42907 20903 28175 240224 357222 173847 11218
40A 25932 70579 41446 240224 173847 357222 3.31 21196
40B 70579 25932 41446 192914 139943 286371 3.31 17881
40B 71814 12432 28189 192914 139943 286371 9884
50 71814 12432 28189 192914 190020 280764 10078
60 72992 48114 39027 192914 228410 256395 10241
70 72992 48114 39027 192914 308782 161039 11190
80 74056 74517 57544 192914 356969 283076 13026
90 74056 74517 57544 192914 874864 953728 27672

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1Db) (ft-1b)
50 Valve 72235 25773 25553 192914 190020 280764
60 72235 25773 25553 192914 228410 256395
70 Valve 73462 61019 47401 192914 308782 161039
80 73462 61019 47401 192914 356969 283076

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 51726 92203 49390 684511 314542 269107
20A 51726 92203 49390 292648 159374 269107
20A 49619 88997 49171 292648 159374 269107
20B 49619 88997 49171 194992 240224 174239
20B 25748 62757 27470 194992 240224 174239
30 25748 62757 27470 469922 240224 170459
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
30 20903 42907 28175 469922 240224 170459
40A 20903 42907 28175 357222 240224 173847
40A 41446 25932 70579 357222 240224 173847
40B 41446 25932 70579 286371 139943 192914
40B 28189 12432 71814 286371 139943 192914
50 28189 12432 71814 280764 190020 192914
60 39027 48114 72992 256395 228410 192914
70 39027 48114 72992 161039 308782 192914
80 57544 74517 74056 283076 356969 192914
90 57544 74517 74056 953728 874864 192914

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY MZ
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 25553 25773 72235 280764 190020 192914
60 25553 25773 72235 256395 228410 192914
70 Valve 47401 61019 73462 161039 308782 192914
80 47401 61019 73462 283076 356969 192914
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Combination of Local Element Forces and Moments using Absolute Sum

(Missing Mass NOT included and Seismic Displacements NOT defined)

Node Type fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-lb) (ft-1b) (ft-lb)

10 49390 92203 51726 269106 314542 684511
20A 49390 92203 51726 269106 159374 292648
20A | Bend 49171 88997 49619 269106 159374 292648
20B 88997 49171 49619 240224 174239 194992
20B 62757 25748 27470 240224 194992 174239

30 62757 25748 27470 240224 469922 170459

30 42907 20903 28175 240224 469922 170459
40A 42907 20903 28175 240224 357222 173847
40A | Bend 25932 70579 41446 240224 173847 357222
408 70579 25932 41446 192914 139943 286371
408 71814 12432 28189 192914 139943 286371

50 71814 12432 28189 192914 190020 280764

50 | Valve 72235 25773 25553 192914 190020 280764

60 72235 25773 25553 192914 228410 256395

60 72992 48114 39027 192914 228410 256395

70 72992 48114 39027 192914 308782 161039

70 | Valve 73462 61019 47401 192914 308782 161039

80 73462 61019 47401 192914 356969 283076

80 74056 74517 57544 192914 356969 283076

90 74056 74517 57544 192914 874864 953728
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Transformation to Global Element Forces and Moments

(Missing Mass NOT included and Seismic Displacements NOT defined)

Node Type FX FY Fz MX MY MZ
(Ib) (Ib) (Ib) (ft-Ib) (ft-Ib) (ft-Ib)

10 51726 92203 49390 684511 314542 269106
20A 51726 92203 49390 292648 159374 269106
20A | Bend 49619 88997 49171 292648 159374 269106
20B 49619 88997 49171 194992 240224 174239
20B 25748 62757 27470 194992 240224 174239

30 25748 62757 27470 469922 240224 170459

30 20903 42907 28175 469922 240224 170459
40A 20903 42907 28175 357222 240224 173847
40A | Bend 41446 25932 70579 357222 240224 173847
40B 41446 25932 70579 286371 139943 192914
40B 28189 12432 71814 286371 139943 192914

50 28189 12432 71814 280764 190020 192914

50 | Valve 25553 25773 72235 280764 190020 192914

60 25553 25773 72235 256395 228410 192914

60 39027 48114 72992 256395 228410 192914

70 39027 48114 72992 161039 308782 192914

70 | Valve 47401 61019 73462 161039 308782 192914

80 47401 61019 73462 283076 356969 192914

80 57544 74517 74056 283076 356969 192914

90 57544 74517 74056 953728 874864 192914
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Annexure C

NRL procedure for combing modes
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NRL Method

The following NRL Sum formula developed by the Naval Research Laboratory (NRL) is used for
calculating the total response (displacements and forces).

where,

Ri = Total (combined) response

Ria= value of the largest response among all the modes
Rip = value of the response due to the nth mode

N = Number of significant modes

Verification of NRL Method

A new feature is added in CAEPIPE Version 7.60 to automatically export in csv format Element Forces
and Moments in Local coordinate system contributed by each mode participating in Response Spectrum
analysis.

In order to verify the implementation of modal summation by NRL method, a CAEPIPE model has been
created with name “RespSpectrumNRL.mod”. A Response Spectrum load was defined and included in
the analysis with Mode Sum = NRL. In addition, the option “Include Missing Mass” was turned “ON” and
“Seismic Displacements” were entered at Anchor Nodes.

Analysis was then performed to export the modal Element Forces and Moments in CSV format as stated
above. The Element Forces and Moments thus contributed by each mode are then combined manually
using the NRL method equation listed above and compared against the Element Forces and Moments
obtained from CAEPIPE by selecting NRL method.

From the comparison results, it was noted that the values obtained by manual combinations are
exactly matching with the CAEPIPE computed element forces and moments for Response
Spectrum loadings.

CAEPIPE Input file for the model “RespSpectrumNRL.mod” along with CAEPIPE Response Spectrum
Element Forces and Moments results for NRL summation as well as the Forces and Moments manually
combined from .CSV results are given below in this section.

In addition to the above, the displacement and acceleration results obtained from CAEPIPE for NRL
summation for the model “ResSpec_NRLSum_DISP_ACC.mod” (available in the folder
“\Verification\NRL\Model_1\DISP_ACC?”) are verified against the manually combined displacements and
accelerations using NRL summation and presented in this section.

CAEPIPE input file, results file, modal forces and moments output file (.csv) and element forces and
moments combined manually using NRM summation are available in the folder ““NRL\Model_1\MFM” for
reference. Similarly, CAEPIPE input file, results file and displacements & accelerations combined
manually using NRM summation are available in the folder “.\Verification\NRL\Model_1\DISP_ACC ” for
reference.

Similar verification is also carried out for a complex model with 650+ elements. The CAEPIPE input file,
results file, modal element forces and moments output file in csv format, modal element forces and
moments manually combined using excel, modal displacements and accelerations manually combined
using excel for NRL summation are available in the folder “.\Verification\NRL\Bigmodel” for reference. As
the reports run into a few hundred pages (425+), they are not presented in this section.
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Caepipe RespSpectrumNRL Page 1
Version 7.60 Verification of NRL Modal Summation Jul 19,2016

Piping code = B31.1 (2014)

Do not use liberal allowable stresses
Do not include axial force in stress calculations
Reference temperature = 40 (F)

Number of thermal cycles = 7000
Number of thermal loads =1

Thermal = Operating - Sustained

Use modulus at reference temperature
Include hanger stiffness

Include Bourdon effect

Use pressure correction for bends
Pressure stress = PD / 4t

Peak pressure factor = 1.00

Cut off frequency = 110 Hz

Number of modes = 5

Include missing mass correction

Use friction in dynamic analysis
Vertical direction =Y

# Node Type DX (ft'in") DY (ft'in") DZ(ft'in") Mat Sec Load Data

1
2
3 Spectrum = Test

4 Mode Sum Combination = NRL

5 Direction Sum Combination = SRRS
6 Include Missing Mass = Yes

7 Seismic Displacements at Anchors
8 Node 10: X =Y = 0.5 inch Z = 0

9 Node 65: X =Y = -0.5 inch 2 = 0
10
11 10 From Anchor
12 20 Bend 11'o" API 541 541
13 30 -20'0" API 541 541
14 40 Bend -10'9" API 541 541
15 50 9'o" API 541 541
16 60 Valve 2'0" API 540 540
17 62 Valve 1'o" API 540 540
18 65 9ro" API 540 540 Anchor
Anchors
(1b/inch) (in-1b/deq) Releases Anchor
Node KX/kx KY/ky KZ/kz KXX/kxx KYY/kyy K2ZZ/kzz X Y Z XXYYZZ In Pipe
10 Rigid Rigid Rigid Rigid Rigid Rigid GCs
65 Rigid Rigid Rigid Rigid Rigid Rigid GCS
Bends
Bend Radius Thickness Bend Flex. Int. Angle 1Int. Angle
Node (inch) (inch) Matl Factor ©Node (deg) Node (deq)
20 81 L
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________________________________________ Benas

Bend Radius Thickness Bend Flex. Int. Angle Int. angle
Node (inch) (inch) Matl Factor Node (deqg) Node (deg)

a0 e L

Node Type Load X(inch) Y (inch) 7 (inch) XX (deg) YY (deg) 7Z2Z (deg) In Pipe
10 Anchor T1
Seis 0.5 0.5 0.0 GCS
65 Anchor T1
Seis -0.5 -0.5 0.0 GCS
Valves
Weight Length Thick Insul Add Wght DX DY DZ
From To (1b) (inch) X Wgt X (1lb) (inch) (inch) (inch)
50 60 0 3.00 1.75
60 62 0 3.00 1.75

Pipe material API: API 5L Grade B

Density = 0.283 (lb/in3), Nu = 0.300, Joint factor = 1.00, Type = CS

Temp E Alpha Allowable
(F) (psi) (in/in/F) (psi)
-325 31.4E+6 5.00E-6 20000
-200 30.8E+6 5.35E-6 20000
-100 30.2E+6 5.65E-6 20000
70 29.5E+6 6.07E-6 20000
200 28.8E+6 6.38E-6 20000
300 28.3E+6 6.60E-6 20000
400 27.7E+6 6.82E-6 19900
500 27.3E+6 7.02E-6 19000
600 26.7E+6 7.23E-6 17900
650 26.1E+6 7.33E-6 17300
700 25.5E+6 7.44E-6 16700
750 24 .8E+6 7.54E-6 13900
800 24 .2E+6 7.65E-6 11400
850 23.3E+6 7.75E-6 8700
900 22 .4E+6 7.84E-6 5900
950 21.4E+6 7.91E-6 4000
1000 20.4E+6 7.97E-6 2500
1050 19.2E+6 8.05E-6 1600
1100 18.0E+6 8.12E-6 1000
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Nominal 0.D. Thk Cor.Al M.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th
Name Dia. Sch (inch) (inch) (inch) (%) (1b/£ft3) (inch) (1lb/ft3) (inch)
361 36" STD 36 0.375 0.075 0.0 13 2
360 36" STD 36 0.375 0.075 0.0 13 2.5
540 Non Std 54 0.375 0.075 0.0 13 2.5
541 Non Std 54 0.375 0.075 0.0 13 2
Loads

X spectrum: Test Factor = 1.0000

Y spectrum: Test Factor = 1.0000

7 spectrum: Test Factor = 1.0000

Mode sum = NRL Direction sum = SRSS

Pipe Loads

Load T1 Pl T2 P2 T3 P3 Specific Add.Wgt Wind

Name (F) (psi) (F) (psi) (F) (psi) gravity (lb/ft) Load

360 100 125 1.000 77.2 Y

361 100 125 1.000

540 100 125 1.000 111.1 Y

541 100 125 1.000

Frequency Displacement

(Hz) (inch)
8 2
30 2
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Local & Global Element Forces and Moments for Response Spectrum from CAEPIPE
using NRL modal summation for Model: RespSpectrumNRL.mod

Caepipe RespSpectrumNRL Page 1
Version 7.60 Verification of NRL Modal Summation Jul 19,2016

Pipe element forces in local coordinates: Response spectrum

fx fy fz mx my mz SL+S0O
Node (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b) SIF (psi)
10 2886158 2646215 1436041 3069679 6915296 14183467 238085
20A 2886158 2646215 1436041 3069679 1670216 3943230 81538
20A 1738090 1702378 551336 3069679 1670216 3943230 3.31 195966
20B 1702378 1738090 551336 2779195 1657014 4525448 3.31 204141
20B 888282 299416 614246 2779195 4525448 1657014 84828
30 888282 299416 614246 2779195 6719519 2974994 117064
30 594051 278063 535978 2779195 6719519 2974994 117064
40A 594051 278063 535978 2779195 5136839 2255935 94153
40A 840381 1389294 665007 2779195 2255935 5136839 3.31 227318
40B 1389294 840381 665007 2733141 2250682 3971821 3.31 194241
40B 2248750 982361 687818 2733141 2250683 3971821 80844
50 2248750 982361 687818 2733141 2740630 3483326 79588
62 3632871 1645451 1202054 2733141 3960584 4631168 101199
65 3632871 1645451 1202054 2733141 13732266 16749208 320218

Other forces in local coordinates: Response spectrum

fx fy fz mx my mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve2570557 1089285 818815 2733141 2740630 3483326
60 2570557 1089285 818815 2733141 3431691 3953386
60 Valve2791102 1153208 885884 2733141 3431691 3953386
62 2791102 1153208 885884 2733141 3960584 4631168

Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
10 1436041 2646215 2886158 14183467 6915296 3069679
20A 1436041 2646215 2886158 3943230 1670216 3069679
20A 551336 1702378 1738090 3943230 1670216 3069679
20B 551336 1702378 1738090 4525448 2779195 1657014
20B 299416 888282 614246 4525448 2779195 1657014
30 299416 888282 614246 6719519 2779195 2974994
30 278063 594051 535978 6719519 2779195 2974994
40A 278063 594051 535978 5136839 2779195 2255935
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Element forces in global coordinates: Response spectrum

Node FX (1b) FY (1b) FZ (1b) MX (ft-1b) MY (ft-1b) MZ (ft-1b)
40A 665007 840381 1389294 5136839 2779195 2255935
40B 665007 840381 1389294 3971821 2250682 2733141
40B 687818 982361 2248750 3971821 2250683 2733141
50 687818 982361 2248750 3483326 2740630 2733141
62 1202054 1645451 3632871 4631168 3960584 2733141
65 1202054 1645451 3632871 16749208 13732266 2733141

Other forces in global coordinates: Response spectrum

FX FY FZ MX MY Mz
Node Type (1b) (1b) (1b) (ft-1b) (ft-1b) (ft-1b)
50 Valve 818815 1089285 2570557 3483326 2740630 2733141
60 818815 1089285 2570557 3953386 3431691 2733141
60 Valve 885884 1153208 2791102 3953386 3431691 2733141
62 885884 1153208 2791102 4631168 3960584 2733141
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Local Element Forces and Moments using NRL Modal Sum
(Missing Mass included and Seismic Displacements defined)

Node | Type | fx fy fz mx my mz
(Ib) (Ib) (Ib) (ft-1b) (ft-1b) (ft-1b)

10 2886159 | 2646215 | 1436040 | 3069678 | 6915297 14183469
20A 2886159 2646215 1436040 | 3069678 1670216 3943229
20A Bend | 1738090 1702377 | 551335 3069678 1670216 3943229
20B 1702377 1738090 | 551335 2779195 1657015 4525448
20B 888282 299415 614247 2779195 | 4525448 1657015
30 888282 299415 614247 2779195 6719519 2974994
30 594052 278064 535977 2779195 | 6719519 2974994
40A 594052 278064 535977 2779195 | 5136838 2255936
40A Bend | 840381 1389294 | 665007 2779195 2255936 5136838
40B 1389294 | 840381 665007 2733142 2250682 3971821
40B 2248751 | 982362 687818 2733142 2250682 3971821
50 2248751 | 982362 687818 2733142 2740630 3483326
50 Valve | 2570557 1089286 | 818815 2733142 2740630 3483326
60 2570557 1089286 | 818815 2733142 | 3431690 3953385
60 Valve | 2791103 1153208 | 885884 2733142 | 3431690 3953385
62 2791103 1153208 | 885884 2733142 | 3960584 4631168
62 3632872 1645451 1202054 | 2733142 | 3960584 4631168
65 3632872 1645451 1202054 | 2733142 13732267 16749209
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Transformation to Global Element Forces and Moments
(Missing Mass included and Seismic Displacements defined)

Node | Type | FX FY Fz MX MY Mz
(Ib) (Ib) (Ib) (ft-Ib) (ft-1b) (ft-1b)
10 1436040 2646215 2886159 14183469 6915297 3069678
20A 1436040 2646215 2886159 3943229 1670216 3069678
20A Bend | 551335 1702377 1738090 3943229 1670216 3069678
20B 551335 1702377 1738090 4525448 2779195 1657015
20B 299415 888282 614247 4525448 2779195 1657015
30 299415 888282 614247 6719519 2779195 2974994
30 278064 594052 535977 6719519 2779195 2974994
40A 278064 594052 535977 5136838 2779195 2255936
40A Bend | 665007 840381 1389294 5136838 2779195 2255936
40B 665007 840381 1389294 3971821 2250682 2733142
40B 687818 982362 2248751 3971821 2250682 2733142
50 687818 982362 2248751 3483326 2740630 2733142
50 Valve | 818815 1089286 2570557 3483326 2740630 2733142
60 818815 1089286 2570557 3953385 3431690 2733142
60 Valve | 885884 1153208 2791103 3953385 3431690 2733142
62 885884 1153208 2791103 4631168 3960584 2733142
62 1202054 1645451 3632872 4631168 3960584 2733142
65 1202054 1645451 3632872 16749209 13732267 2733142
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Global Displacements & Accelerations for Response Spectrum from CAEPIPE using
NRL modal summation for Model: RespSpec_NRLSum_DISP_ACC.mod

Caepipe ResSpec NRLSum DISP ACC Page 1
Version 7.60 Jul 19,2016

Piping code = B31.3 (2014)

Do not use liberal allowable stresses
Include axial force in stress calculations
Reference temperature = 40 (F)

Number of thermal cycles = 7000

Number of thermal loads =1

Thermal = Operating - Sustained

Use modulus at reference temperature
Include hanger stiffness

Include Bourdon effect

Use pressure correction for bends
Pressure stress = PD / 4t

Peak pressure factor = 1.00

Cut off frequency = 110 Hz

Number of modes = 5

Do not include missing mass correction
Use friction in dynamic analysis
Vertical direction = Y

# Node Type DX (ft'in") DY (ft'in") DZ(ft'in") Mat Sec Load Data
1 Title =
2 10 From Anchor
3 20 Bend 11'o" API 541 541
4 30 -20'0" API 541 541
5 40 Bend -10'9" API 541 5471
6 50 9'o" API 541 541
7 60 Valve 2'0" API 540 540
8 62 Valve i'o" API 540 540
9 65 9ro" APIT 540 540 Anchor
Anchors
(1b/inch) (in-1b/degq) Releases Anchor
Node KX/kx KY/ky KZ/kz KXX/kxx KYY/kyy KZZ/kzz X Y Z XXYYZZ In Pipe
10 Rigid Rigid Rigid Rigid Rigid Rigid GCS
65 Rigid Rigid Rigid Rigid Rigid Rigid GCs
Bends
Bend Radius Thickness Bend Flex. Int. Angle 1Int. Angle
Node (inch) (inch) Matl Factor Node (deg) Node (deq)
20 81 L
40 81 L
Valves
Weight Length Thick Insul Add Wght DX DY DZ
From To (1b) (inch) X Wgt X (1b) (inch) (inch) (inch)
50 60 0 3.00 1.75
60 62 0 3.00 1.75
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Pipe material API: API 5L Grade B

Density = 0.283 (1lb/in3), Nu = 0.300, Joint factor = 1.00, Type = CS
Yield strength = 35000 (psi)

Temp E Alpha Allowable
(F) (psi) (in/in/F) (psi)
-325 31.4E+6 5.00E-6 20000
-200 30.8E+6 5.35E-6 20000
-100 30.2E+6 5.65E-6 20000
70 29.5E+6 6.07E-6 20000
200 28.8E+6 6.38E-6 20000
300 28.3E+6 6.60E-6 20000
400 27.7E+6 6.82E-6 19900
500 27.3E+6 7.02E-6 19000
600 26.7E+6 7.23E-6 17900
650 26.1E+6 7.33E-6 17300
700 25.5E+6 7.44E-6 16700
750 24 .8E+6 7.54E-6 13900
800 24 .2E+6 7.65E-6 11400
850 23.3E+6 7.75E-6 8700
900 22 .4E+6 7.84E-6 5900
950 21.4E+6 7.91E-6 4000
1000 20.4E+6 7.97E-6 2500
1050 19.2E+6 8.05E-6 1600
1100 18.0E+6 8.12E-6 1000

Nominal 0.D. Thk Cor.Al M.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th
Name Dia. Sch (inch) (inch) (inch) (%) (1b/ft3) (inch) (1lb/ft3) (inch)
361 36" STD 36 0.375 0.075 0.0 13 2
360 36" STD 36 0.375 0.075 0.0 13 2.5
540 Non Std 54 0.375 0.075 0.0 13 2.5
5471 Non Std 54 0.375 0.075 0.0 13 2
Loads

X spectrum: Test Factor = 1.0000

Y spectrum: Test Factor = 1.0000

Z spectrum: Test Factor = 1.0000

Mode sum = NRL Direction sum = SRSS

Load T1 Pl T2 P2 T3 P3 Specific Add.Wgt Wind
Name (F) (psi) (F) (psi) (F) (psi) gravity (1b/ft) Load
360 100 125 1.000 77.2 Y
361 100 125 1.000

540 100 125 1.000 111.1 Y
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Load T1 Pl T2 P2 T3 P3 Specific Add.Wgt Wind
Name (F)  (psi) (F) (psi) (F)  (psi) gravity (lb/ft) Load
541 100 125 1.000

Frequency Displacement

(Hz) (inch)

8 2

30 2
Caepipe ResSpec NRLSum DISP ACC Page 1
Version 7.60 Jul 19,2016

Displacements: Response spectrum

Node X (inch) Y (inch) Z (inch) XX (deqg) YY (deg) 727 (deq)
10 0.000 0.000 0.000 0.0053 0.0023 0.0020
20A 0.142 0.299 0.017 0.2903 0.1186 0.2013
20B 2.062 2.293 1.718 0.7323 1.0475 1.1207
30 2.761 2.336 3.176 0.4478 1.2040 1.0978
40A 3.380 2.340 3.082 0.3125 1.2663 1.0228
40B 2.524 2.584 0.087 0.9512 0.9503 0.5132
50 2.032 2.078 0.072 0.9630 0.9482 0.4190
60 1.620 1.657 0.067 0.9533 0.9368 0.3922
62 1.416 1.448 0.065 0.9433 0.9264 0.3788
65 0.000 0.000 0.000 0.0095 0.0093 0.0018

(g's)

Node X Y Z

10 0.000 0.000 0.000
20A 3.290 6.853 0.458
20B 33.414 33.650 19.805
30 45.930 34.728 72.447
40A 50.400 34.833 74.225
40B 81.290 71.012 2.534
50 67.308 57.609 2.076
60 54.988 46.344 1.941
62 48.766 40.716 1.873
65 0.000 0.000 0.000
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Manually Combined Displacement Results using NRL Summation

X Y Z

0 0 0
0.138 0.289 0.019

2.07 2.285 1.71

2.754 2.342 3.183
3.383 2.342 3.072
2.53 2.579 0.094
2.029 2.086 0.076
1.624 1.648 0.076
1.428 1.458 0.076

0 0 0

Manually Combined Accelerations Results using NRL Summation

X Y VA

0 0 0
3.101 6.536 0.635
33.547 33.544 19.547
45.813 34.937 72.467
50.592 34.937 73.986
81.55 71.087 2.631
67.383 57.73 2.029
54.906 46.211 2.029
49.071 40.909 2.029

0 0 0
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Annexure D
Generation of Mesh for Buried Piping Layout

(Automatic Discretization of Buried Piping Layout)

Note: This feature was implemented in CAEPIPE Version 7.50. Minor changes incorporated in this Version 7.60
related to this feature are highlighted by the vertical line along the margin in this write-up.
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Generation of Mesh for Buried Piping Layout
Modulus of Subgrade Reaction (k)

This factor k defines the resistance of the soil or backfill to pipe movement due to the bearing pressure at
the pipe/soil interface. Several methods for calculating modulus of subgrade reaction (k) have been
developed in recent years.

As per Trautmann, C.H., and O’Rourke, T.D., “Lateral Force-Displacement Response of Buried Pipes,”
Journal of Geotechnical Engineering, ASCE, Vol. 111, No. 9 Sep 1985, pp. 1077-1092, the modulus of
subgrade reaction, k, can be calculated as per Eqg. (2) in Appendix VIl of ASME B31.1-2014 code.

k =C,N,wD

where,

Ck = a dimensionless factor for estimating horizontal stiffness of compacted backfill. C, may be estimated
at 20 for loose soil, 30 for medium soil, and 80 for dense or compacted soil. In the current version of
CAEPIPE, the value of Cy is internally set as 80 for both cohesive and cohesionless sail.

D = pipe outside diameter
w = soil density

Ni = a dimensionless horizontal force factor from Fig. 8 of above stated technical paper. For a typical
value where the soil internal friction angle is 30 deg. the curve from Fig. 8 may be approximated by a
straight line defined by

N, = 0.285H/D + 4.3
where
H = the depth of pipe below grade at the pipe centerline
Influence Length (L)

The influence length is defined as the portion of a transverse pipe run which is deflected or “influenced” by
pipe thermal expansion along the axis of the longitudinal run.

From Hetenyi’'s theory, (Beams on Elastic Foundation, The University of Michigan Press, Ann Arbor,
Michigan 1967) (also, see Section VII-3.3.2 of Appendix VII of ASME B31.1-2014 code)

Lo
ap

where,

4EI

E = modulus of elasticity of pipe at reference temperature

1/4
k
Pipe / Soil System Characteristics = ﬂ = ‘:

| = moment of inertia of pipe cross section

k = modulus of subgrade reaction of soil as detailed above.
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Implementation in CAEPIPE

It is in the bends, elbows, and branch connections that the highest stresses are found in buried piping
subjected to thermal expansion of the pipe. These stresses are due to the soil forces that bear against the
transverse run. The stresses are proportional to the amount of soil deformation at the elbow or branch
connection. Hence, piping element at the junction of bend, elbow and branch connection is to be refined in
the stress layout.

This can be performed through Layout Window > Edit > Refine Nodal Mesh. Select the radio button
“Buried piping” from the dialog box shown.

B Caepipe: Layout (10) - [ . R1.mod (D:\KPD Verification\Verificat... ~— o x
File Edit View Options Loads Misc Window Help
Edit type.. Ctrl+ T Q
iwi -
Edit data. CurteD Refine Modal Mesh for o
Copy.. cut-C i)

Paste.. Crl+V

L)

Find and Replace... Ctrl+H Anchor
AP (12 |1
AP (12 |1
EREEE

APz 1

Insert Ctri+Ins
Delete... CtrleX
split.

Multiple Split...

" Dynarnic Analpsis

M azs Modeling Frequency (Hz] |33

When the command is selected, CAEPIPE will refine the Nodal Mesh as detailed below.

Slope.
Rotate...

[=[=[>[=[~]=[=]~]=]]
.

APL1Z L

Lhange.. AP |12 (L1

Combine... Ctrl+B

EE
=

Renumber nodes...
Refine Nodal Mesh Ctrl+R

Generate...

Regenerate

=

Calculate modulus of subgrade reaction (k) as detailed above. While calculating k, the value of Cy
is taken as 80 for both cohesive and cohesionless soil.

2. Calculate influence length (L) for the element that is fully buried.

3. If the length of the pipe element near bend / elbow / branch connection is greater than or equal to
the influence length (Ly), then the pipe element will be split into a number of short elements with
length of each short element being equal to 2 x OD of that pipe section until the Influence length

(L)

On the other hand, if the length of the pipe element near bend / elbow / branch connection is less
than the influence length (L) and greater than 2 x OD of the pipe, then the pipe element will be
split into a number of short elements with length of each short element being equal to 2 x OD of
that pipe section.

Note: while refining the Nodal Mesh, the new node numbers will be generated by adding the node
increment specified through Layout window > Options > Node increment to get the new node numbers
(without affecting the original node numbers used in the Layout window). Hence, set the node increment
value as required before refining the Nodal Mesh.
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Sample buried piping model
The following data are used to generate the sample buried piping model.

Piping code = B31.1 (2014)

Use liberal allowable stresses

Do not include axial force in stress calculations
Reference temperature = 70 (F)
Number of thermal cycles = 7000
Number of thermal loads =1

Thermal = Operating - Sustained

Use modulus at reference temperature
Include hanger stiffness

Include Bourdon effect

Use pressure correction for bends
Pressure stress = PD / 4t

Peak pressure factor = 1.00

Cut off frequency = 33 Hz

Number of modes = 20

Include missing mass correction

Use friction in dynamic analysis
Vertical direction = Y

Pipe material API: API 5L

Density = 0.283 (1lb/in3), Nu = 0.300, Joint factor = 0.85, Type = CS

Temp E Alpha Allowable
(F) (psi) (in/in/F) (psi)
-20 27.9E+6 6.25E-6 10900
100 27.9E+6 6.47E-6 10900
200 26.8E+6 6.70E-6 10900
300 25.3E+6 6.90E-6 10900
400 24.7E+6 7.10E-6 10900

Nominal 0.D. Thk Cor.Al M.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th
Name Dia. Sch (inch) (inch) (inch) (%) (1b/ft3) (inch) (1lb/ft3) (inch)
12 22" STD 12.75 0.375 O 0.0
Soils
Name Type Density Strength Delta Ks Ground Level
(lb/£ft3) (psi) (deqg) (ft'in")
S1 Cohesionless 130 30 0.30 12'o"

Load T1 Pl T2 P2 T3 P3 Specific Add.Wgt Wind
Name (F) (psi) (F) (psi) (F) (psi) gravity (1b/ft) Load
Ll 140 100

65



HH Caepipe: Layout (10) - [BuriedPipingExample.mod (D:A\KPDevelopm... — O >
File Edit Yiew Options Loads Misc Window Help

T TBEE BEE

# |Node | Type | D [ftin")| D (ftin”) | DZ [itin") | Matl | Sect | Load | Data

1 [Tite =

2 |10 |From Anchor
3 |20 |Bend|E00" APL 12 |LT

4 [B0_JEend 000" &R |12 U

5 |40 2500" AP 12 |L1

6 |50 1500 AP [12|L1

7 | Branch

5 |40 |From

3 |60 |Bend 500" |&Rl 12 L1

1070 507" APL 12 |LT

?

¥ Cacpipe : Graphics - [BuriedPipingExample.mod (D:\KPDevelopment\Verification\Verification7.50\BuriedPipingDiscretization]] - O X

File View Options Window Help

=
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Soil characteristics

Soil density, w = 130 Ib/ft3 = 0.075 Ib/in®

Pipe depth below grade, H = 12 ft (144 in)

Type of backfill, dense sand (cohesion less soil)

Ck=80

Calculation of Modulus of subgrade reaction (k)
Nj = 0.285H/D + 4.3

Nj =(0.285 x 144 / 12.75) + 4.3 = 7.518

k =C,N,wD =80 x 7.518 x 0.075 x 12.75 = 575.127 psi

Calculation of Influence Length (L)
Moment of inertia, | = 279.3 in*

Modulus of elasticity, E = 27.9 x 10° psi
3z

L ="
4B

174
k
Pipe / Soil System Characteristics = ff = ‘:E =[575.127 / (4 x 27.9 x 106 x 279.3)] ¥*=0.01165

Influence Length (LK) =3 x 3.14 / (4 x 0.01165) = 202.145 in

As the length of pipe element near the bend and branch connection is greater than the influence length (L
=202.145 in), the pipe elements near the bends and branch connection are split into a number of short
elements with length of each short element being equal to 2 x OD = 2 x 12.75 = 25.5 in until the influence
length (Ly). See figures given below for details.

1 ¥4 Caepipe : Graphics - d (O rifcation\Verification. P retization)] - o x
‘ File Edit File View indow Help

0 [} Qaao

# [ Node | Type [0 (itin') D (i) D2 1) [ Ml [ Sect [ Load [Data_ ~ [ ~
[ Jmite= /T\‘
2 |10 [Fem Anchr 3 .
‘3_20 %0517 AP 12 |01 u z *
ENED 212" AP 12 |01

5 |40 212" 4P 12 |01

E 212" AP 12 |01

7 |e0 212" 4P 12 |01 180

(8 _|m 212" 4P 12 |01

(3 |0 214" 4Pl 12 |01

ES 214" 4Pl 12 |01

[ [100 212" BAEERE

[z |110 212" BAEERE

3 |12 212" BAEERE

(4 |130 212" BAEERE o

15 |140 212" BAEERE

[16 |150 21172 AP (12 |L1

[17 |160 21172 AP (12 |L1

[18 |10 21172 APL[12 L1

[13 |180 |Bend|30733 APL[12 L1

[20 |130 211727 |4 12 (L1

[21 |200 211727 |4 12 (L1
[22 |20 211727 |4 12 (L1
[23 |220 211727 |4 12 (L1
[24 |230 211727 |4 12 (L1
[ |20 211720 AR 12 (L
[ |50 211720 AR 12 (L
[z |260 211720 AR 12 (L
[28 |2m0 211720 AR 12 (L
[23 |230 211720 AR 12 (L
[30 |230 211720 AR 12 (L
[31 |30 211720 AR 12 (L
[32 |30 211727 AR 12 (L1
[33 |20 211727 AR 12 (L1
[34 |30 211727 AR 12 (L1
[ |30 211727 AR 12 (L1
[3 |30 30817 |4R 12 (L1
[37 |380 211727 AR 12 (L1
[38 |am 211727 AR 12 (L1
[33 |380 211720 AR 12 (L1
[40 |3m0 211720 AR 12 (L1
(41400 212 [ap 12 |1
[42 |40 212 [ap 12 |1

43 |420 212 |ap 12 |1

44 |43 212" 4P |12 |1 0
(% |40 212 |ap 1z |0
(% _|450 212" |aR 12 |1 v
47 | 480 212 Jap iz 0 vl < >
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